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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

CAUTION  
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken. 

 

CAUTION  
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken. 

 

NOTICE  
indicates that an unintended result or situation can occur if the corresponding information is not taken into 
account. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation for the specific task, in particular its warning notices and 
safety instructions. Qualified personnel are those who, based on their training and experience, are capable of 
identifying risks and avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

WARNING  
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be adhered to. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this 
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the 
owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 

 

 Siemens AG 
Industry Sector 
Postfach 48 48 
90026 NÜRNBERG 
GERMANY 

 A5E02477571-02  
Ⓟ 03/2010 

Copyright © Siemens AG 2010. 
Technical data subject to change

이 기기는 업무용(A급) 전자파 적합기기로서 판매자 또는 사용자는 이 점을 주의하시기 바라며 가정 외의 지역에서 사용하는 것을 목적으로 합니다.
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Preface 

Purpose of the operating instructions 
These operating instructions provide information based on the requirements defined by DIN 
EN 62079 for mechanical engineering documentation. This information relates to the place of 
use, transport, storage, mounting, use and maintenance. 
These operating instructions are intended for the following user groups: 
● Operators 

The following chapters are of relevance: 
– Overview (Page 11)  
– Operating the Thin Client  (Page 95)  

● Administrator 
The following chapters are of relevance: 
– Overview (Page 11)  
– Configuring the Thin Client (Page 53)  
– Configuring the server (Page 87)  

● Commissioning engineers 
The following chapters are of relevance: 
– Overview (Page 11)  
– Mounting and connecting (Page 37)  
– Configuring the server (Page 87) 

● Maintenance personnel 
The following chapters are of relevance: 
– Overview (Page 11)  
– Maintenance and care (Page 111)  

Chapter Safety instructions and general notes (Page 23) must be particularly observed by all 
user groups. 

Basic knowledge required 
General knowledge of automation technology and process communication is needed to 
understand the operating instructions. 
It is also assumed that those using the manual have experience in using personal computers 
and knowledge of Microsoft operating systems. 
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Scope of the operating instructions  
These operating instructions apply to the following HMI devices: 
● Thin Client 10" Touch 
● Thin Client 15" Touch 
● Thin Client PRO 15" 
The term "Thin Client" includes all three listed Thin Client HMI devices. 

 

NOTICE  
The manual is part of the HMI device and will be required for future commissioning. This 
means the following for the entire service life of the HMI device: Keep the supplied and 
supplementary documentation stored together. You must pass on all these documents to 
future owners of the HMI device. 

 

Registered trademarks  
The following designations marked with the symbol ® are registered trademarks of 
Siemens AG: 
● HMI® 
● SIMATIC® 
● WinCC® 

Conventions  
The following text notation will facilitate reading this manual: 
 
Notation Scope 
"Add screen"  Terminology that appears in the user interface, for example 

dialog names, tabs, buttons, menu commands 
 Required input, for example, limits, tag values. 
 Path information 

"File > Edit" Operating sequences, for example, menu commands, shortcut 
menu commands 

<F1>, <Alt+P> Keyboard operation 

Please observe notes labeled as follows:  
 

 Note 
Notes contain important information concerning the product, its use or a specific section of 
the documentation to which you should pay particular attention. 
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Illustrations in this manual 
This documentation includes illustrations associated with the product. These illustrations 
may differ from the factory state of the product. 

Technical Support 
Technical support for the products covered in the manual is available in the Internet at: 
● Technical Support  

(http://support.automation.siemens.com/) 
● Support Request  

(http://support.automation.siemens.com/WW/view/en/16605654) 
● Service  

(http://support.automation.siemens.com/WW/view/en/16604318) 
● Contacts and office locations  

(http://www.automation.siemens.com/mcms/aspa-db/en/Pages/default.aspx) 
● Training center  

(http://sitrain.automation.siemens.com/sitrain/default.aspx?AppLang=en) 

Additional information on SIMATIC products is available in the Internet at: 
● Industry Portal  

(http://www.automation.siemens.com/_en/portal/index.htm) 
● Overall SIMATIC documentation 

(http://www.automation.siemens.com/simatic/portal/html_76/techdoku.htm) 

Recycling and disposal  
The HMI devices described in these operating instructions can be recycled due to the low 
levels of pollutants. Contact a certified disposal service company for environmentally sound 
recycling and disposal of your old devices. 

 

http://support.automation.siemens.com/WW/llisapi.dll?aktprim=99&lang=en&referer=%2fWW%2f&func=cslib.csinfo2&siteid=csius&extranet=standard&viewreg=WW�
http://support.automation.siemens.com/WW/view/en/16605654�
http://support.automation.siemens.com/WW/view/en/16604318�
http://www.automation.siemens.com/mcms/aspa-db/en/Pages/default.aspx�
http://sitrain.automation.siemens.com/sitrain/default.aspx?AppLang=en�
http://www.automation.siemens.com/_en/portal/index.htm�
http://www.automation.siemens.com/simatic/portal/html_76/techdoku.htm�
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Overview 1
1.1 Product overview 

Thin Clients – cost-effective HMI devices on site  
In large or extensive systems, as cost-effective terminals, Thin Clients offer on-site operating 
functionality. The Thin Client helps to obtain a better overview, usability and productivity of 
the system. The Thin Client also considerably reduces the total costs of ownership (TCOs) 
due to the simplest commissioning, reduced software costs and minimized service outlay. 
The Thin Client always communicates through the following client applications with a host, 
such as an HMI device, Panel PC or Server: 
● Sm@rtAccess 
● Standard RDP (Remote Desktop Protocol) from Microsoft 
● VNC (Virtual Network Computing) from Olivetti and Oracle 
● On-demand application service of Citrix 
● SINUMERIK connection 
The Thin Client itself does not require any installation, no licenses and no additional 
software. You can also bridge greater distances via Ethernet. 
Using Sm@rtAccess you can operate WinCC flexible projects on other HMI devices or Panel 
PCs from the Thin Client. Use RDP to operate HMI applications, such as WinCC, and Office 
applications, such as MS Excel or SAP, directly on the Thin Client on the machine. With 
VNC you operate a PC using the Thin Client remote, similarly to RDP. With Citrix you 
centrally offer each user an individual desktop with applications. In case of the SINUMERIK 
connection, the Thin Client becomes a SINUMERIK Thin Client Unit (TCU). 

Hardware equipment 
The Thin Client is supplied with a 10" or 15" TFT display with 64 K colors. You operate the 
Thin Client via the touch screen or a keyboard or mouse that is connected to the USB port. 
The Thin Client plug-in devices are compatible in terms of mounting cutout and design with 
the HMI devices MP 277 and MP 377 of the respective dimensions. 

IP65 all-round 
The Thin Client PRO with an IP65 housing has an all-round dust- and hose water degree of 
protection. The ready-to-use HMI device can be fixed either from the top or the bottom to a 
supporting arm system or to a stand. 
A basic adapter and adapter sets that can be ordered separately support fixing systems from 
various manufacturers (including VESA standard for flat screens). The rear wall can be 
removed quite easily. The interfaces of the HMI device can therefore be reached without any 
problems. You do not require any special cables or connectors. 
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The Thin Client PRO is impressive not only on account of its ease of servicing but also due 
to its sophisticated design and slimline device depth. 

Simple starting up 
The Thin Client merely requires an IP address. Local software installations or configurations 
are not necessary on the Thin Client. The display and user interface are made available by 
the host. 

Considerable robustness 
As a detached operating element without any rotating media (hard drive and fans), you can 
operate the HMI device on machines that have a particularly high demand on mechanical 
robustness. 

1.2 Design of the Thin Client Touch 

Front view and side view 10" Touch  

 
① Touch screen 
② Recesses for mounting clamps 
③ Mounting seal 
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Bottom view 10" Touch  

 
① "Factory settings" key 
② Interfaces 
③ Recesses for mounting clamps 

Rear view 10" Touch  

 
① Rating plate 
② Interface name 
③ Ground connection 
④ Fixing elements for strain relief 
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Front view and side view 15" Touch  

 
① Touch screen 
② Recesses for mounting clamps 
③ Mounting seal 

Bottom view 15" Touch  

 
① "Factory settings" key 
② Interfaces 
③ Recesses for mounting clamps 
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Rear view 15" Touch  

 
① Rating plate 
② Interface name 
③ Ground connection 
④ Fixing elements for strain relief 
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1.3 Thin Client PRO 15" 

1.3.1 Structure of the Thin Client PRO 15" 

Front view and side view  

 
① Display with touch screen 
② Housing 
③ Housing rear wall 

Bottom view  

 
① Cover, bottom 
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Rear view  

 
① Cover, can be installed with screws on top 
② Housing rear wall 
③ Cover, installed with screws on bottom 

 

1.3.2 Structure of the basic adapter 

 
① Seal 
② Cable channel 
③ Mechanical interface to the Thin Client PRO 
④ Mechanical interface to Extension Unit 
⑤ Mechanical interface for the adapter from the adapter set 

The basic adapter is included in the delivery scope of the Thin Client PRO 15". An adapter 
set belongs to the basic adapter, which can be ordered as an accessory. The basic adapter 
and adapter set are required to mount the Thin Client PRO to a supporting arm or on a 
stand. The order information for the adapter set is available in the section Accessories 
(Page 19).  
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1.4 Accessory kit 

Accessory kit for the Thin Client 10" Touch and the Thin Client 15" Touch  
The accessory kit contains the following: 
● Mains terminal for the power supply 
● Spring clamps for mounting the HMI device 
Additional documents may be enclosed with the accessory kit. 

Accessory kit for the Thin Client PRO 15"  
The accessory kit contains the following: 
● Mains terminal for the power supply 
● Basic adapter as a basic element for fixing to a supporting arm 
● Four screws for fixing the basic adapter to an adapter from an adapter set 
Additional documents may be enclosed with the accessory kit. 

Mounting clamps  
Spring clamps or metal mounting clamps are provided for mounting the device. The 
mounting clamps hook into oblong holes on the HMI device. The overall dimensions of the 
HMI device are not exceeded by this type of installation. 
 
Spring clamp Metal mounting clamp 

 
① Slot 

② Hook 

 
① Threaded pin 

② Hook 

The HMI device is shipped with a product information with instructions on how to fasten the 
HMI device with the spring clamps. 
The metal mounting clamps are part of the service pack with order number 
6AV6671-8XC00-0AC0. The service pack is shipped with a product information with 
instructions on how to fasten the HMI device with the metal mounting clamps. 
You can download the product information in the Internet at the following link: 
● Product Information "Metal mounting clamp" 

(http://support.automation.siemens.com/WW/view/en/34915725) 
● Product Information "Spring clamp" 

(http://support.automation.siemens.com/WW/view/en/34916893) 

http://support.automation.siemens.com/WW/view/en/34915725�
http://support.automation.siemens.com/WW/view/en/34916893�
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1.5 Accessories 
In addition to the scope of delivery, you can order the following accessories online in the 
Industry Mall (http://mall.automation.siemens.com). 

Protective foil  
You can obtain protective foil for the Thin Client´s touch screen. The protective foil is not part 
of the scope of delivery of the HMI device. 
The following order numbers apply to the protective foils: 

HMI device Order no. 
Thin Client 10" Touch 6AV6671-3DC00-0AX0 
Thin Client 15" Touch, Thin Client PRO 15" 6AV6574-1AD00-4EX0 

Clamping frame  
A clamping frame is available for the Thin Client 10" Touch and the Thin Client 15" Touch. If 
the material thickness around the mounting cutout is very low, you will reach IP54 degree of 
protection with additional mounting clamps from one of the service packs for IP65 degree of 
protection. For additional information, see Section Preparing for installation (Page 32). 
The following order numbers apply to the clamping frames: 

HMI device Order no. 
Thin Client 10" Touch 6AV6671-8XS00-0AX0 
Thin Client 15" Touch 6AV6671-8XS01-0AX0 

Service packs for the Thin Client 10" Touch and the Thin Client 15" Touch  
For a certain material thickness at the mounting cutout and to ensure protection class IP65 
you need to install additional mounting clamps that are included in the service packs. For 
additional information, see Section Preparing for installation (Page 32). 
The service packs are available with the following order numbers: 

Mounting clamps Order no. 
Spring clamps 6AV6671-6AP00-0AX0 
Metal mounting clamps 6AV6671-8XC00-0AC0 

Basic adapter  
The basic adapter is included in the delivery scope of the Thin Client PRO 15". The basic 
adapter can be ordered as an accessory with the order number 6AV7674-0KA00-0AA0 . 

USB port  

 
A dust and splash-water proof USB port is included in the scope of delivery of the Thin 
Client PRO 15". 

http://mall.automation.siemens.com/�
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Adapter sets for supporting arm systems  
The following adapter sets are available for the Thin Client PRO 15": 
 
Adapter set Suitable for supporting arm systems Order no. 
Adapter set VESA75 VESA75-compatible systems 6AV7674-0KE00-0AA0 
Adapter set VESA100 VESA100-compatible systems,  

Rose GTN II supporting arm systems 
6AV7674-0KD00-0AA0 

Extension Unit 15"  
Use Extension Unit 15" to install additional operator controls and displays on the Thin Client 
PRO 15". The Extension Unit 15" is available with order number 6AV7674-0KG00-0AA0. 

1.6 Typical application scenarios for the Thin Client 
Thin Clients can be used in different scenarios as operating terminals. With the Thin Client, 
for example, you can access HMI devices and hence control a work process. You can also 
use the Thin Client to operate office applications on a server, for example, on a PC. 
The following illustrates two typical application scenarios.  

Sm@rtAccess - Client  
The Thin Client acts as a Sm@rtAccess client to access an HMI device or a Panel PC. You 
can use the Thin Client to monitor or operate a WinCC flexible project. 
The following figure shows a possible configuration. 
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Access to a server via "RDP".  
The Thin Client uses RDP (Remote Desktop Protocol) to access a server, such as a Panel 
PC or a PC. The following application scenarios are also possible. 
● WinCC/Web Navigator 

The Thin Client uses an Internet browser to access the server as a web navigator client 
on the WinCC/Web Navigator. In this case, the operating system Windows Server 2003 
or 2008 must be installed on the server. For more information, refer to the documentation 
for the WinCC/Web Navigator option. 

● Windows XP SP3 and Windows 7 operating systems 
The Thin Client accesses an office application, such as MS Excel or an SAP application, 
on the server. In contrast to the Windows Server operating systems, you can only operate 
one screen with Windows XP and Windows 7. The other monitor is always blocked. 

● Windows Server 2003 SP2 operating system 
The Thin Client accesses an office application running under Windows Server 2003, such 
as MS Excel or an SAP application, on the server. 

● Windows Server 2008 operating system 
The following figure shows a possible configuration using the Windows Server operating 
system on a Panel PC/PC. 

 

Access to SINUMERIK  
The Thin Client accesses the system network of the SINUMERIK through the SINUMERIK 
connection. The system network configures the Thin Client to a SINUMERIK Thin Client Unit 
(TCU). Using the TCU you control and monitor a SINUMERIK PCU 50.3 with PCU 
Basesoftware XP V8.6 SP1 or higher  or SINUMERIK NCU 7x0.2 with CNC software V2.6 
SP1 or higher. 
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1.7 Product brief - connecting and starting the HMI device 

Procedure  
 
Step See also 
Thin Client 10" Touch, Thin Client 15" Touch 
Position the HMI device in the mounting cutout and 
use clamping frames to fix the HMI device. 
Thin Client PRO 15" 
Use the basic adapter and an adapter set to fix the 
HMI device to a supporting arm or on a stand. 

Installing the Thin Client 10" Touch and Thin 
Client 15" Touch (Page 38)  
 
 
 
Installing the Thin Client PRO 15" 
(Page 41)  

Connect the equipotential bonding. Connection of equipotential bonding 
(Page 45)  

Connect the power supply. Connecting the power supply (Page 47)  
Connect PROFINET. Connecting the Thin Client to PROFINET 

(Page 49)  
Optional: Connect an external USB device. Connecting a USB device (Page 49)  
Switching on the power supply. Switching on and testing the HMI device 

(Page 50)  
Call the configuration settings. Structure and functions of the taskbar 

(Page 99)  
Switch on the network connection of the Thin Client. Network settings (Page 58)  
Enter the IP addresses and further access parameters 
of the required server. 

Editing client-server connections (Page 65)  

Establish a new administrator password for the 
configuration settings. 

Administrator password (Page 56)  

Close the configuration settings.  
Start the requested client application. Structure and functions of the taskbar 

(Page 99)  
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Safety instructions and general notes 2
2.1 Safety instructions 

The following information applies to all Thin Clients. 

High frequency radiation  
 

NOTICE  
Unwanted operating states 
High frequency radiation, for example from a cell phone, causes unintentional operating 
situations. 

 

Installation according to the instructions  
 

WARNING  
Installation only in machinery that conforms to the machinery directive 
Commissioning of the HMI device is forbidden until it has been absolutely ensured that the 
machine in which the HMI device is to be installed complies with Directive 98/37/EC or 
Directive 2006/42/EC as of 29 December 2009. 

 

Safety instructions for the Thin Client 10" Touch, Thin Client 15" Touch  
The following information applies to HMI devices Thin Client 10" Touch, Thin Client 15" 
Touch. 

Working on the control cabinet 
 

WARNING  
Open equipment 
The HMI device is open equipment. This means that the HMI device may only be mounted 
in housings or cabinets, whereby the device can be operated from the front panel. 
The cubicle or cabinet in which the HMI device is installed may only be accessed with a key 
or tool and only by trained, authorized personnel.  
Dangerous voltage 
When you open the control cabinet, you may have access to parts that carry dangerously 
high voltages. 
Always disconnect the cabinet from the mains before opening it. 
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2.2 Standards, certificates and approvals 

Approvals  
 

CAUTION  
The following overview shows possible approvals. The HMI device itself is certified as 
shown in the approvals on its rear panel. 

 

CE approval  
The HMI device meets the general and safety-related requirements of the following EC 
directives and conforms to the harmonized European standards (EN) for programmable logic 
controllers published in the official gazettes of the European Union: 
● 2004/108/EC Electromagnetic Compatibility Directive (EMC Directive) 

UL approval  
Underwriters Laboratories Inc., to  
● UL 508 (Industrial Control Equipment) 
● CSA C22.2 No. 142 (Process Control Equipment) 

Marking for Australia  
The HMI device fulfills the requirements of standard AS/NZS 2064 (Class A). 

EU declaration of conformity, approvals and certificates  
You request copies of the certificates and associated reports from the following address: 
Siemens AG 
Industry Sector 
I IA AS RD ST 
PO Box 1963 
92209 Amberg 
Germany 
Certificates are available on the Internet at "Technical Support 
(http://support.automation.siemens.com)". Select "Product Support". 

N117 

http://support.automation.siemens.com/WW/llisapi.dll?aktprim=99&lang=en&referer=%2fWW%2f&func=cslib.csinfo2&siteid=csius&extranet=standard&viewreg=WW�
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2.3 Notes about usage 

Use in industry  
The HMI device is designed for industrial use, limit class A. For this reason, the following 
standards are met: 
● Requirements for emitted interference, EN 61000-6-4:2007 
● Requirements for immunity to interference, DIN EN 61000-6-2:2005 

Residential use  
 

NOTICE  
Interference with radio / TV reception 
The HMI device is not suitable for use in residential areas: 
When you operate the HMI device in a residential area, you must ensure Limit Class B 
conforming to EN 55016 regarding emission of radio interference. 

 

A suitable measure for achieving the required RF interference level for Limit Class B 
includes for example: 
● Installation of the HMI device in grounded control cabinets 
● Use of filters in electrical supply lines 
Individual acceptance is required.  
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2.4 Electromagnetic compatibility 

Introduction 
The HMI device fulfills requirements of the EMC directive of the domestic European market 
and other requirements. 

EMC-compliant installation of the HMI device  
The EMC-compliant installation of the HMI device and the application of interference-proof 
cable is the basis for interference-free operation. The description, "Guidelines for 
Interference-Free Construction of PLCs" is also valid for mounting the HMI device. 

Pulse-shaped interference  
The following table shows the electromagnetic compatibility of modules with regard to pulse-
shaped interference. This requires the HMI device to meet the specifications and directives 
for electrical installation. 
 
Pulse-shaped 
interference 

Test voltage Degree of severity 

Electrostatic discharge 
in accordance with IEC 
61000-4-2 

Air discharge: 8 kV 
Contact discharge: 6 kV 

3 

Bursts 
(high-speed transient 
interference) 
in accordance with 
IEC 61000-4-4 

2 kV power supply cable 
2 kV signal cable, > 30 m 
1 kV signal cable, < 30 m 

3 

High-power surge pulses in accordance with IEC 61000-4-5, external protective circuit required (refer 
to S7-300 PLC, Installation, chapter “Lightning and overvoltage protection”). 
Asymmetrical coupling 2 kV power cable 

DC voltage with protective elements 
2 kV signal/data cable, > 30 m, 
with protective elements as required 

3 

Symmetrical coupling 1 kV power cable 
DC voltage with protective elements 
1 KV signal cable, > 30 m, 
with protective elements as required 

3 
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Sinusoidal interference  
The following table shows the EMC behavior of the modules with respect to sinusoidal 
interference. This requires the HMI device to meet the specifications and directives for 
electrical installation. 
 
Sinusoidal interference Test values Degree of 

severity 
HF radiation 
(electromagnetic fields) 
according to 
IEC 61000-4-3 

 80% amplitude modulation at 1 kHz 
with 10 V/m in the range of 80 MHz to 1 GHz 
with 3 V/m in the range 1.4 GHz to 2 GHz 
with 1 V/m the range 2 GHz to 2.7 GHz 

 10 V/m with 50% pulse modulation at 900 MHz 
10 V/m with 50% pulse modulation at 1.89 GHz 

3 

HF power applied to lines 
and line shields according 
IEC 61000-4-6 

Test voltage 10 V, with 80% amplitude modulation of 1 
kHz in the 9 MHz to 80 MHz range 

3 

Emission of radio interference  
The following table shows the unwanted emissions from electromagnetic fields in 
accordance with EN 55016, Limit Value Class A, Group 1, measured at a distance of 10 m. 
 
From 30 to 230 MHz < 40 dB (μV/m) quasi-peak 
From 230 to 1000 MHz < 47 dB (μV/m) quasi-peak 

Additional measures 
Before you connect an HMI device to the public network, ensure that it is compliant with Limit 
Value Class B in accordance with EN 55022.  
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2.5 Transport and storage conditions 

Mechanical and climatic conditions for transportation and storage  
The transport and storage conditions of this HMI device exceed requirements in accordance 
with IEC 61131-2. The following specifications apply to the transport and storage of an HMI 
device in its original packaging.  
The climatic conditions conform to the following standards: 
● IEC 60721-3-3, Class 3K7 for storage 
● IEC 60721-3-2, Class 2K4 for transportation 
Mechanical requirements conform to EC 60721-3-2, Class 2M2. 
 
Type of condition Permitted range 
Drop test (in transport package) ≤ 1 m 
Temperature From –20 to +60 °C 
Atmospheric pressure From 1,140 hPa to 660 hPa, 

corresponds to an elevation of -1,000 m to 3,500 m 
Relative humidity From 10 to 90 %, without condensation 
Sinusoidal vibration in accordance with 
IEC 60068-2-6 

5 to 9 Hz: 3.5 mm 
9 Hz to 500 Hz: 9.8 m/s2 

Shock in accordance with IEC 60068-2-29 250 m/s2, 6 ms, 1,000 shocks 

 
 

NOTICE  
Danger of condensation and malfunctioning  
If the HMI device is exposed to low temperatures or extreme fluctuations in temperature 
during transportation, moisture may occur on or inside the HMI device. 
The HMI device must have acquired room temperature before it is put into operation. Do 
not expose the HMI device to direct radiation from a heater in order to warm it up. If 
condensation has developed, wait approximately 4 hours until the HMI device has dried 
completely before switching it on.  

 

Proper transport and storage, installation and assembly as well as careful operation and 
maintenance are required to ensure trouble-free and safe operation of the HMI device. 
The warranty for the HMI device will be deemed void if these stipulations are not heeded. 
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Planning application 3
3.1 Notes about usage 

Mechanical and climatic conditions of use  
The HMI device is designed for use in a location protected from the effects of the weather. 
The conditions of use are compliant with requirements to DIN IEC 60721-3-3: 
● Class 3M3 (mechanical requirements) 
● Class 3K3 (climatic requirements) 

Use with additional measures  
The HMI device should not be used at the following locations unless additional measures are 
taken: 
● In locations with a high degree of ionizing radiation 
● In locations with difficult operating conditions, for example due to: 

– Corrosive vapors, gases, oils or chemicals 
– Electrical or magnetic fields of high intensity 

● In systems that require special monitoring, for example: 
– Elevators 
– Systems in especially hazardous rooms 

Mechanical operating conditions  
The following table contains the characteristics for permitted vibration values. 
 
Frequency band Constant  Occasional 
10 Hz ≤ f ≤ 58 Hz Amplitude 0.0375 mm Amplitude 0.075 mm  
58 Hz ≤ f ≤ 150 Hz Constant acceleration 0.5 g Constant acceleration 1 g 

Attenuating shocks and vibrations  
If the HMI device is subject to severe shocks or vibrations, you must take appropriate 
measures to reduce amplitudes or acceleration. In such cases use vibration-attenuating or 
vibration-extinguishing systems for HMI device and accessories. 
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Testing mechanical operating conditions  
The following table provides information on the type and scope of tests for mechanical 
operating conditions. 
 
Test Remark 
Vibrations 
Test according to 
IEC 60068, Part 2–6 (sinusoidal) 

Type of vibration: 
Transitional rate of the frequency: 1 octave/minute. 
5 Hz ≤ f ≤ 9 Hz, 
Constant amplitude 3.5 mm 
9 Hz ≤ f ≤ 150 Hz, 
Constant acceleration 1 g, with support arm 0.5 g on the basic 
adapter 
Vibration duration: 
10 frequency cycles per axis in each of the three mutually 
vertical axes. 

Shock 
Test according to 
IEC 60068, Part 2–27 

Type of shock: Half-sine 
Shock intensity: 
Peak value 15 g, duration 11 ms 
Direction of impact: 
3 shocks in ± directions in each of the three mutually vertical 
axes 

Climatic operating conditions  
The following table shows the permitted climatic operating conditions for the device. 
 
Ambient conditions  Permitted range Comments 
Temperature 
 Vertical installation 

Thin Client 10" Touch, 
Thin Client 15" Touch 
Thin Client PRO 15" 

 Tilted installation 
Thin Client 10" Touch, 
Thin Client 15" Touch 
Thin Client PRO 15" 

 
 
From 0 to 50° C 
From 0 to 50° C 
From 0 to 45 C 
 
From 0 to 40° C 
From 0 to 40° C 
From 0 to 45 C 

Refer to the "Mounting positions 
and type of fixation" chapter 

Relative humidity 10% to 80%, without condensation Corresponds to relative humidity, 
load degree 2 according to 
IEC 61131, Part 2 

Atmospheric pressure 1,140 to 795 hPa Corresponds to an elevation of –
1 000 to 2 000 m 

SO2: < 0.5 vpm;  
Relative humidity < 60%, no 
condensation 

Test: 10 cm3/m3; 10 days Pollutant concentration 

H2S: < 0.1 vpm;  
Relative humidity < 60%, no 
condensation 

Test: 1 cm3/m3; 10 days 
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3.2 Thin Client 10" Touch and Thin Client 15" Touch 

3.2.1 Mounting positions 

Mounting position  
The HMI device is suitable for installation in: 
● Mounting cabinets 
● Control cabinets 
● Switchboards 
● Consoles 
In the following, all of these mounting options are referred to by the general term "cabinet". 
The HMI device is self-ventilated and approved for vertical and inclined mounting in 
stationary cabinets. 

– +

 
 Mounting position Deviation from the vertical 
① Inclined ≤ 35° 
② Vertical 0° 

 

CAUTION  
Damage due to overheating  
Convection through the HMI device is reduced with installation at an angle.This fact also 
reduces the maximum permitted operating temperature for operation. 
Operate the HMI device at an inclined mounting position up to the permitted ambient 
temperature for vertical installation with sufficient forced ventilation. 
Otherwise the HMI device loses its approvals and the warranty may become obsolete. 
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3.2.2 Preparing for installation 

Select the mounting location of the HMI device  
Points to observe when selecting the mounting location: 
● Position the HMI device so that it is not subjected to direct sunlight. 
● Position the HMI device such that it is ergonomically accessible for the user. Choose a 

suitable mounting height. 
● Ensure that the air vents of the HMI device are not covered as a result of the mounting. 
● Observe the permissible mounting positions for the HMI device. 

 

NOTICE  
 

Stability of the mounting cut-out 
The material in the area of the mounting cut-out must provide sufficient strength to 
guarantee the enduring and safe mounting of the HMI device. 
The force of the clamps or operation of the device may not lead to deformation of the 
material in order to achieve the degrees of protection described below. 
The material thickness at the mounting cut-out must be at least 1.0 mm. 

 

Degrees of protection  
The following degrees of protection are possible: 
● Degree of protection IP54 or degree of protection Enclosure Type 12 (indoor use only) 
● Degree of protection IP65 or degree of protection 

Enclosure Type 4X/Type 12 (indoor use only) 
To ensure degree of protection IP65, additional mounting clamps are required. The 
additional mounting clamps are available in the service pack. 
Service packs for Thin Client 10" Touch and 15" Touch are available with the following 
order numbers: 
– With spring clamps: Order number 6AV6671-6AP00-0AX0 
– With metal mounting clamps: order number 6AV6671-8XC00-0AC0 

To ensure degree of protection IP54 or IP65, you will have to meet the following 
requirements: 
● Permitted deviation from plane at the mounting cut-out: ≤ 0.5 mm 

This condition must be fulfilled for the mounted HMI device. 
● Permissible surface roughness in the area of the seal: ≤ 120 µm (Rz 120) 
● The material thickness at the mounting cut-out must be at least 6 mm. 

Spring clamps or metal mounting clamps, each with or without clamping frames, are used 
depending on the material thickness at the mounting cut-out. 
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The relationships are shown in the table below: 
 
Material thickness Spring clamp Metal mounting clamp  Clamping frame required 
1.0 to 1.5 mm x x Yes 
1.5 to 2 mm x 

- 
- 
x 

No 
Yes 

2 to 4 mm x - No 
4 to 6 mm - x No 

The clamping frame is available as an accessory, see section Accessories (Page 19). 

Dimensions of the mounting cut-out  
The following table shows the dimensions of the required mounting cut-out: 
 
Mounting cut-out Thin Client 10" Touch Thin Client 15" Touch 
Width 310+1 mm 367+1 mm 
Height 248+1 mm 289+1 mm 
Depth of the clearance 61 mm 61 mm 

 
 

 Note 
You can insert a Thin Client 10" Touch into the mounting cutout of the following HMI devices: 
 MP 277 10" Touch 
 MP 377 12" Touch 
You can insert a Thin Client 15" Touch in the mounting cutout of the following HMI device: 
 MP 377 15" Touch 
Please observe the following: 
Insert the HMI device centered in the mounting cutout. Otherwise you cannot fix the upper 
mounting clamps in position. 
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Maintaining clearances  
The HMI device must be installed with the following clearances:  
● Always allow 50 mm above and below the mounting cutout respectively for ventilation 
● Right and left of the mounting cut-out respectively for attaching the mounting clamps: 

– When using spring clamps: 25 mm each 
– When using metal mounting clamps: 15 mm each 
– When using a clamping frame, independent of the type of mounting clamp used: 25 

mm each 
● At least 10 mm clearance in addition to the mounting cutout of the HMI device is required 

at the rear 
 

NOTICE  
 

Ensure that the maximum ambient temperature is not exceeded when mounting the 
device in a cabinet and especially in a closed enclosure.  

 

3.2.3 Information on insulation tests, protection class and degree of protection 

Test voltages  
Insulation strength is demonstrated in the type test with the following test voltages in 
accordance with IEC 61131-2: 

Circuits with a nominal voltage of Ue to other 
circuits or ground 

Test voltage 

< 50 V 500 VDC 

Protection class  
Protection Class I in accordance with IEC 60536, i.e. PE/ground terminal to profile rail 
required! 

Protection against foreign objects and water  

The following degree of protection applies to the HMI device: 

Degree of protection in 
accordance with IEC 60529 

Explanation 

Front When mounted: 
 IP54, optional IP65 
 Enclosure type 12 (indoor use only), optional enclosure type 

4X/type 12 (indoor use only) 

Rear panel IP20 
Touch protection test with standard test probes. There is no 
protection against the penetration of water. 
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The degrees of protection at the front can only be guaranteed if the mounting seal is installed 
flush to the mounting cutout. 

 

 Note 
IP65 degree of protection 
To achieve IP65 degree of protection, when installing the HMI device you must also use 
mounting clamps from the service pack. 
The service packs are available with the following order numbers: 
 With spring clamps: Order number 6AV6671-6AP00-0AX0 
 With metal mounting clamps: order number 6AV6671-8XC00-0AC0 

 

3.2.4 Rated voltages 
The table below shows the rated voltage and the corresponding tolerance range.  
 
Rated voltage Tolerance range 
+24 VDC 19.2 to 28.8 V (+/–20%) 

3.3 Thin Client PRO 15" 

3.3.1 Mounting positions 

Mounting position 
The HMI device is self-ventilated and approved for vertical and inclined mounting. 

– +

 
 Mounting position Deviation from the vertical 
① Inclined ≤ 45° 
② Vertical 0° 
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3.3.2 Preparing for installation 

Select the mounting location of the HMI device 
Points to observe when selecting the mounting location: 
● Position the HMI device so that it is not subjected to direct sunlight. 
● Position the HMI device such that it is ergonomically accessible for the user. Choose a 

suitable mounting height. 
● Observe the permissible mounting positions for the HMI device. 

3.3.3 Information on insulation tests, protection class and degree of protection 

Test voltages  
Insulation strength is demonstrated in the type test with the following test voltages in 
accordance with IEC 61131-2: 
 
Circuits with a nominal voltage of Ue to other 
circuits or ground 

Test voltage 

< 50 V 500 VDC 

Protection class  
Protection Class I in accordance with IEC 60536, i.e. PE/ground terminal to profile rail 
required! 

Protection against foreign objects and water  
The following degree of protection applies to the HMI device: 
 
Device side Degree of protection in accordance with IEC 60529 
all sides  IP65 

 Enclosure Type 12 (indoor use only) 
 Enclosure Type 4X/Type 12 (indoor use only) 

3.3.4 Rated voltages 
The table below shows the rated voltage and the corresponding tolerance range.  
 
Rated voltage Tolerance range 
+24 VDC 19.2 to 28.8 V (+/–20%) 
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Mounting and connecting 4
4.1 Checking the package contents 

Check the package content for visible signs of transport damage and for completeness.  
 

NOTICE  
If a part is damaged 
A damaged part will cause the HMI device to malfunction. 
Do not install parts damaged during shipment. In the case of damaged parts, contact your 
Siemens representative. 

 

Thin Client 10" Touch and Thin Client 15" Touch is available in the delivery scope as follows: 
● HMI device 
● Accessory kit with mounting clamps and mains terminal 
● CD with source codes for the open source software 
The following is supplied along with the Thin Client PRO 15": 
● HMI device 
● Mains terminal 
● Basic adapter for fixing to a supporting arm 
● Four screws for fitting the basic adapter 
● CD with source codes for the open source software 
Additional documents may be included in the delivery. 
The documentation belongs to the HMI device and is required for subsequent 
commissioning. Retain all enclosed documentation for the entire service life of the HMI 
device. You must pass on the enclosed documentation to any subsequent owner or user of 
the HMI device. Make sure that every supplement to the documentation that you receive is 
stored together with the operating instructions.  
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4.2 Installing or dismantling the HMI device 

4.2.1 Installing the Thin Client 10" Touch and Thin Client 15" Touch 

Requirement 
All packaging components and protective foils should be removed from the HMI device.  
To install the HMI device, you need the mounting clamps from the accessories. The 
mounting seal must be fitted on the HMI device. If the mounting seal is damaged, order a 
replacement seal. The mounting seal is part of the service packs.  
The service packs can be ordered separately with the following order numbers: 
● With spring clamps: Order number 6AV6671-6AP00-0AX0 
● With metal mounting clamps: order number 6AV6671-8XC00-0AC0 
To ensure the necessary degree of protection on the HMI device, the mounting clamps must 
observe the positions listed below. 

Procedure  
 

NOTICE  
Always mount the HMI device according to the instructions in these operating instructions. 

 

Proceed as follows: 
1. Check that the mounting seal is fitted on the HMI device. 

Do not install the mounting seal turned inside out. A mounting seal that is turned inside 
out will cause leaks at the mounting cutout. 

2. Insert the HMI device into the mounting cut-out from the front. 
3. Insert a mounting clamp into a recess on the HMI device. 
4. Fasten the mounting clamp as described in the corresponding product information. You 

can download the product information for metal mounting clamps or spring clamps in the 
Internet at the following links: 
– Product Information "Metal mounting clamp" 

(http://support.automation.siemens.com/WW/view/en/34915725) 
– Product Information "Spring clamp" 

(http://support.automation.siemens.com/WW/view/en/34916893) 
5. Repeat steps 3 and 4 for all mounting clamps required for installation of the HMI device. 

 

NOTICE  
 

Check the fit of the mounting seal on the front. The mounting seal must not protrude 
from the HMI device. 
Otherwise, repeat steps 1 to 5.  

 

http://support.automation.siemens.com/WW/view/en/34915725�
http://support.automation.siemens.com/WW/view/en/34916893�


 Mounting and connecting 
 4.2 Installing or dismantling the HMI device 

Thin Client, Thin Client PRO 
Operating Instructions, 03/2010, A5E02477571-02 39 

Positioning the mounting clamps on the Thin Client 10" Touch  
In total, you will need 6 mounting clamps for the installation with IP54 degree of protection. 
The following figure shows the correct positions of the mounting clamps. 

 

IP65 degree of protection 
For the Thin Client to achieve IP65 degree of protection, you will require six additional 
mounting clamps from the service pack for the installation. Service packs are available with 
the following order numbers: 
● Service pack with spring clamps, order number 6AV6671-6AP00-0AX0 
● Service pack with metal spring clamps, order number 6AV6671-8XC00-0AC0 
In total, you will need 12 mounting clamps for the installation with IP65 degree of protection. 
The following figure shows the correct positions of the mounting clamps.  
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Positioning the mounting clamps on the Thin Client 15" Touch  
In total, you will need 8 mounting clamps for the installation with IP54 degree of protection. 
The following figure shows the correct positions of the mounting clamps.  

 

IP65 degree of protection 
For the Thin Client to achieve IP65 degree of protection, you will require six additional 
mounting clamps from the service pack for the installation. Service packs are available with 
the following order numbers: 
● Service pack with spring clamps, order number 6AV6671-6AP00-0AX0 
● Service pack with metal spring clamps, order number 6AV6671-8XC00-0AC0 
In total, you will need 14 mounting clamps for the installation with IP65 degree of protection. 
The following figure shows the correct positions of the mounting clamps.  

 

See also 
Spare parts and repairs (Page 112) 
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4.2.2 Installing the Thin Client PRO 15" 

Requirement 
All packaging components and protective foils should be removed from the HMI device. 
To install the HMI device, you need the basic adapter and an adapter set from the 
accessories. 
The following cables are fed through the stand or the supporting arm to which the HMI 
device will be fixed: 
● Equipotential bonding cable 
● Power supply cable 
● PROFINET cable 

 

NOTICE  
 

Warranty endangered 
If you install the HMI device not in accordance with the specifications given in these 
operating instructions, the warranty for the HMI device will become void. 
Always install the HMI device according to these operating instructions. 
IP65 degree of protection at risk 
If there are no seals on the adapters or these are damaged, then IP65 degree of 
protection is at risk. Check the condition and seating of the seals. 
If the seal on the rear wall of the housing is damaged, then this can be repaired. For a 
repair scenario, proceed as directed in chapter "Spare parts and repairs (Page 112). 

 

 
 

Note 
The warranty for the IP65 degree of protection assumes that the supporting arm or the 
stand also complies with IP65. 

 

Procedure  
This section describes how to mount the HMI device on a support arm system. Mounting of a 
stand at the bottom of the HMI device is carried out in the same manner. 
Proceed as follows: 
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1. Remove the 10 screws ① from the rear wall of the housing. 

 
2. Remove the rear wall of the housing ② and store it in a secure location. 

 

CAUTION  
 

Destruction of the housing 
If you overtighten the screws, the thread in the support arm head and in the intermediate 
plate will be damaged.  
Tighten the screws in the support arm head and in the intermediate plate with a 
maximum torque of 5.7 Nm.  
Pinching and bending of connection cables 
Before you install the intermediate plate, basic adapter and mechanical interface, you 
should route the connection cables through these components. Make sure that the 
connection cables are not pinched or bent when you tighten the screws. 

 

3. Screw on the intermediate plate ④ from below to the support arm head ③: To do so 
insert the four screws M6 x 12 from the accessories kit of the adapter set through the 
outer holes of the intermediate plate. Check that the seal is properly seated. 

 



 Mounting and connecting 
 4.2 Installing or dismantling the HMI device 

Thin Client, Thin Client PRO 
Operating Instructions, 03/2010, A5E02477571-02 43 

4. Screw on the basic adapter ⑤ from below to the intermediate plate ④: To do so insert 
the four screws M6 x 12 from the accessories kit of the adapter set through the upper 
holes of the basic adapter and fasten the screws into the inner treaded holes of the 
intermediate plate. Check that the seal is properly seated. 

 

CAUTION  
 

Destruction of the housing 
If you overtighten the screws, the thread in the HMI device will be damaged.  
Tighten the screws at the mechanical interface and at the housing rear panel with a 
maximum torque of 0.8 Nm. 

 

5. Hold the HMI device under the support arm head. Screw on the basic adapter ⑤ to the 
top of the mechanical interface of the HMI device. Check that the seal is properly seated. 

6. If you want to connect the cables at a much later point in time, fasten the housing rear 
panel ② back on (see the section "Closing the housing rear wall for the 
Thin Client PRO 15" (Page 51)"). 

7. Fasten the supplied cover with 4 screws at the bottom of the mechanical interface. 

Result 
The HMI device is fitted and can be connected electrically. 
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4.3 Connecting the HMI device 

4.3.1 Overview 

Requirement 
● The HMI device must be mounted according to the specifications of these operating 

instructions. 
● Always use shielded standard cables. 
For order information please refer to Industry Mall (http://mall.automation.siemens.com). 

Connection sequence  
Connect the HMI device in the following sequence: 
1. Equipotential bonding 
2. Power supply 
3. PROFINET 
4. I/Os as necessary 

 

CAUTION  
 

Damage in case of incorrect connection sequence  
Ensure you connect the HMI device in the sequence stipulated above. 

 

Disconnect the HMI device by completing the above steps in reverse order. 

Connecting the cables  
When connecting the cables, ensure that the contact pins are not bent. Secure the cable 
connectors by screwing the connector onto the housing of the HMI device. 
Provide adequate strain relief for all cables. For this purpose, the Thin Client PRO 15" has a 
strain relief rail fitted beneath the interfaces. 
The pin assignment of the ports is described in the technical specifications.  

See also 
Safety instructions (Page 23) 
Power Supply (Page 119) 
USB (Page 120) 
LAN (PROFINET) (Page 120) 

http://mall.automation.siemens.com/�
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4.3.2 Ports 
The following figure shows the interfaces available on the Thin Client.  

 
① LAN interface (PROFINET) 
② USB port 
③ Power supply connector 

 

4.3.3 Connection of equipotential bonding 

Differences in electrical potential  
Differences in electrical potential can develop between spatially separated plant 
components. Such electrical potential differences can lead to high equalizing currents over 
the data cables and therefore to the destruction of their interfaces. Equalizing currents can 
develop if the cable shielding is terminated at both ends and grounded to different plant 
parts.  
Differences in potential may develop when a system is connected to different mains 
supplies. 

General requirements for equipotential bonding  
Differences in potential must be reduced by means of equipotential bonding in order to 
ensure trouble-free operation of the relevant components of the electronic system. The 
following must therefore be observed when installing the equipotential bonding circuit: 
● The effectiveness of equipotential bonding increases as the impedance of the 

equipotential bonding conductor decreases or as its cross-section increases. 
● If two plant parts are interconnected by means of shielded data cables and their shielding 

is bonded at both ends to the grounding/protective conductor, the impedance of the 
additionally installed equipotential bonding cable must not exceed 10% of the shielding 
impedance. 

● The cross-section of an equipotential bonding conductor must be capable of handling the 
maximum equalizing current. Experience has shown that equipotential bonding 
conductors with a minimum cross-section of 16 mm² should be fitted between the control 
cabinets or the ground point of the supporting arm or the stand for PRO HMI devices. 

● Use equipotential bonding conductors made of copper or galvanized steel. Establish a 
large surface contact between the equipotential bonding conductors and the 
grounding/protective conductor and protect these from corrosion. 
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● Use a suitable cable clip to clamp the shield of the data cable flush to the equipotential 
bonding rail. Keep the length of cable between the HMI device and the equipotential 
bonding rail as short as possible. 

● Route the equipotential bonding conductor and data cables in parallel and with minimum 
clearance between these. 

Wiring diagram  

 
① Ground connection on the HMI device, example 
② Equipotential bonding conductor cross-section: 4 mm2

③ Control cabinet 
④ Equipotential bonding conductor cross-section: min. 16 mm2 
⑤ Ground connection 
⑥ Cable clip 
⑦ Equipotential bonding rail  
⑧ Parallel routing of the equipotential bonding conductor and data cable 

 

CAUTION  
Damage to the interface modules possible  
Cable shielding is not suitable for equipotential bonding. 
Use only the prescribed equipotential bonding conductors. The equipotential bonding 
conductor ④ must not be less than 16 mm². The interface modules may otherwise be 
damaged or destroyed. 
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4.3.4 Connecting the power supply 

Configuration graphic 
The following figure shows the connection of the HMI device and the power supply.  

 

Note when connecting 
The mains terminal for connecting the power supply is contained in the accessory kit. The 
mains terminal is designed for cables with a maximum cross-section of 1.5 mm². 

Connecting the mains terminal 
 

CAUTION  
Damage to the socket possible 
If you tighten up the screws on the mains terminal while the mains terminal is connected to 
the HMI device, then the pressure of the screwdriver on the socket could cause damage to 
the HMI device. 
Only connect the wires when the mains terminal is withdrawn. 

 



Mounting and connecting  
4.3 Connecting the HMI device 

 Thin Client, Thin Client PRO 
48 Operating Instructions, 03/2010, A5E02477571-02 

Connect the mains terminal to the cables of the power supply as shown in the following 
figure.  

 
Ensure that the lines are connected properly to the correct terminals. Refer to the label for 
the contact pins on the rear of the HMI device. 

Reverse polarity protection 
The HMI device is equipped with a reverse polarity protection circuit. 

Safe power supply 
 

CAUTION  
Malfunction of the HMI device 
If the supply voltage does not lie within the specified range, there may be operating faults at 
the HMI device. 
Use only 24 VDC power supply units with safe electrical isolation in accordance with IEC 
60364-4-41 or HD 60364-4-41, for example, to SELV / PELV standard.  
Applies to non-isolated plant configurations: Connect the "GND" terminal of the 24 VDC 
power supply to the equipotential bonding. You should always select a central point of 
termination. 

 

See also 
Ports (Page 45) 
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4.3.5 Connecting the Thin Client to PROFINET 

Configuration graphic 
The following figure shows the connection between the HMI device and PROFINET.  

 

See also 
Ports (Page 45) 

4.3.6 Connecting a USB device 
You can connect the USB port to the HMI device of the following devices:  
● Mouse 
● Keyboard 
● Industrial USB Hub 4 
● USB memory devices 

The Thin Client supports only USB memory devices that were formatted with the FAT16 
or FAT32 file system. 

 

NOTICE  
 

Malfunction caused by external device  
A malfunction may arise if you connect an external device with its own power supply and 
without equipotential bonding or excessive current load to the USB port. 
Ensure a non-insulated installation. Observe the values for maximum load of the USB 
port (see the Section Specifications (Page 118)).  
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See also 
Ports (Page 45) 
USB (Page 120) 
SINUMERIK (Page 94) 
Operating a USB memory device (Page 109) 

4.4 Switching on and testing the HMI device 

Procedure - Switching on the HMI device  
Proceed as follows: 
1. Switching on the power supply. 

The screen lights up after power is switched on. Information regarding the included free 
software is displayed during startup. 
If the HMI device fails to start, you have probably crossed the wires on the mains 
terminal. Check the connected wires and change their connection. 

Additional information is available in the configuration settings, Section Connection settings 
(Page 63). Make sure that you observe the warning at the end of the section.  

Function test  
Perform a function test following commissioning. The HMI device is fully functional when one 
of the following states is indicated: 
● The start bar is displayed. 
● The set autostart connection is established. 

Procedure - Switching off the HMI device  
Proceed as follows: 
1. If an autostart connection has been established: Select the menu command "Close" in the 

start bar of the corresponding client application. 
2. Switch off the power supply. 
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4.5 Securing the cables 

4.5.1 Securing the cables on the Thin Client 10" Touch and Thin Client 15" Touch 
After the switch-on test, to ensure strain relief, use cable ties to secure the connected cables 
to the marked fixing elements. 

 

4.5.2 Securing the cables on the Thin Client PRO 15" 
After the switch-on test, to ensure strain relief, use cable ties to secure the connected cables 
to the marked clasps. 

 

4.6 Closing the housing rear wall for the Thin Client PRO 15" 

Requirement 
● All cables are connected. 
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Procedure  
Proceed as follows: 
1. Check that the seal is properly seated on the housing. 

 

NOTICE  
 

IP65 degree of protection at risk 
If the seal on the rear wall of the housing is damaged, the IP65 degree of protection is at 
risk. This is a repair case. Proceed in accordance with chapter Spare parts and repairs 
(Page 112). 

 

2. Position the housing rear wall on the housing. 
Ensure the housing rear wall cannot fall down. 

 

CAUTION  
 

Destruction of the housing 

If you overtighten the screws ① in the housing rear panel, the thread in the HMI device 
will be damaged. Tighten the screws of the housing rear panel using a maximum torque 
of 0.8 Nm. 
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Configuring the Thin Client 5
5.1 Potential fields of application for the Thin Client 

Applications  
The Thin Client can fulfill the following functions as an operator terminal: 
● Access to an HMI device as a client via the WinCC Sm@rtAccess option. 
● Access as a client via the "RDP" protocols (Windows programs) and "VNC". 
● Access as a client to desktops and applications using the Citrix Presentation Server, 

called 
"Citrix XenApp" as of V5.0.  

● Access as SINUMERIK TCU to a SINUMERIK PCU or NCU. 
When accessing a server as a client, for example, an HMI device or a PC, the display of the 
server is depicted on the screen of the Thin Client. The user uses the Thin Client to access 
programs or projects on the server.  

 

 Note 
In the documentation the term "Client application" is used for the various connection types, 
for example "RDP" or Sm@rtAccess. The term "Citrix Presentation Server" is still used as a 
synonym for "Citrix XenApp".  

 

5.2 Configuration settings 

Configuration  
You establish the configuration of the Thin Client in the configuration settings. These include 
the following settings: 
● Network settings 
● Connection settings for remote access 
● Web browser settings 
● Device settings 
● Administrator password 

 

 
 

Note 
Network and connection settings are not required for the SINUMERIK connection. 
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The configuration settings are saved in a configuration file on the Thin Client. Additional 
information on the structure of the configuration file is available in the product information 
"SIMATIC HMI Configuration file Thin Client 
(http://support.automation.siemens.com/WW/view/en/35105485)". 

Calling up the configuration settings, locally or centrally  

You open the configuration settings with the  icon in the start bar and select the 
configuration settings in the selection menu. 
If there is a SINUMERIK connection, you access the SINUMERIK TCU service menu in the 
SINUMERIK selection menu.  
The configuration settings are displayed and modified in the web browser. You exit the 
configuration settings in the selection menu by using the "Close" menu command. 
You can then also enter the address "http://localhost" on the Thin Client in the address bar of 
the Web browser. 
You can also access the Thin Client from an external Web browser by using its valid IP 
address that can be accessed in the network.  
Several persons can be logged on at the same time and change the configuration settings. 
The last settings that were stored successfully are always the currently valid ones ("Enter" 
button). 

 

NOTICE  
Organize access to the configuration settings in such a way that only one person can edit 
the configuration settings at one time. 

 

Access with logon  
For write access to the configuration settings you must log on with a valid administrator 
password. 
"admin" is the default setting for the administrator password. If the default administrator 
password "admin" is still valid, it will be displayed on the start page of the configuration 
settings. 

 

NOTICE  
Unauthorized access 
The default administrator password is visible without logon. This means unauthorized 
personnel may have access to the configuration settings and client-to-server connections.  
After initial commissioning or restoring of the factory settings you should log on with 
"admin" and assign a new administrator password. 
The default setting activates certain services, such as the SSH configuration service. SSH 
offers, for example, an automatic update function which represents a potential security risk. 
If you do not need SSH, then deactivate it. For additional information, please refer to 
"Settings in expert mode (Page 83)". 

 

http://support.automation.siemens.com/WW/view/en/35105485�
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Access without logon  
If you are not logged in, you only have read access to the currently valid network settings 
and the device data such as the IP address and the MLFB of the device. 

Restoring factory settings  
Restoring factory settings has the following effects: 
● The default configuration file overwrites the configuration file. All connection data for the 

network, remote access and web browser is reset. 
 

 
 

Note 
You can, however, back up the configuration file beforehand and restore it again 
afterwards (see Section "Settings in expert mode (Page 83)"). 

 

● The administrator password for logon to the configuration settings is reset to the default 
administrator password "admin." 

● The SSH identifier is reset to the default password. 
 

NOTICE  
 

Resetting to the default password affects the SSH configuration service. Additional 
information is available in the section "Settings in expert mode (Page 83)". 

 

● The calibration information will be deleted. 
 

NOTICE  
 

Faulty touch operation 
The touch screen has to be recalibrated. 

 

To restore factory settings, hold down the "Factory settings" button on the back of the HMI 
device when you switch on the Thin Client until the message "Resetting to factory defaults" 
is displayed on the touch screen. 

Special characters  
Only alphanumeric characters and certain special characters are permitted in some input 
fields of the configuration settings. The system will alert you if you enter special characters in 
these fields that are not permitted. This message will list the permitted special characters. 
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Adjusting the display in the web browser  
The web browser of the Thin Client uses the following freely scalable fonts: 
 
Name of the font Type 
Siemens Sans (True Type) Sans-serif 
Siemens Sans Black (True Type) Sans-serif 
Siemens Sans Black Italic (True Type) Sans-serif 
Siemens Sans Bold (True Type) Sans-serif 
Siemens Sans Bold Italic (True Type) Sans-serif 
Siemens Sans Italic (True Type) Sans-serif 

You can enlarge or reduce the display in the web browser: 
● Use the key combination <CTRL><+> to enlarge the display. 
● Use the key combination <CTRL><-> to reduce the display. 

 

 
 

Note 
Depending on the keyboard you are using, it may be necessary that you press the Shift 
key to access the "+" and the "-" key. In this case, use <Control><Shift><+> to enlarge 
the display and <Control><Shift><-> to reduce it. 

 

See also 
Administrator password (Page 56) 
Read access to configuration settings (Page 84) 
Design of the Thin Client Touch (Page 12) 

5.2.1 Administrator password 

Changing the Administrator password  
Change the Administrator password under "Security > Admin password". The Administrator 
password according to the factory settings is "admin". If this default Administrator password 
is still valid, it will be displayed on the start page of the configuration settings. The standard 
Administrator password is visible without logon. 
The length of the Administrator password is restricted to a maximum of 30 characters. It is 
not possible to enter an empty Administrator password. 
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Forgetting the Administrator password  
If you have forgotten the Administrator password, you must use the standard Administrator 
password. To do this, you must restore the factory settings. 

 

NOTICE  
Losing the current configuration settings  
When restoring to factory settings, the current configuration file is overwritten. 
After restoring to factory settings, the Administrator password "admin" is then valid again. 
For security reasons it is best to enter a new password. 

 

After restoring to factory settings, a saved configuration file can be transferred back to the 
HMI device. 
After restoring the configuration file, the password contained in this is then valid after the 
HMI device is restarted. If you wish, you can change the password and make a note of it. 

See also 
Configuration settings (Page 53) 
Device settings (Page 79) 
Settings in expert mode (Page 83) 
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5.2.2 Network settings 

Introduction 
Under "Network" you can perform the following actions: 
● "Settings" tab: Establishing the network settings  
● "Status" tab: Displaying valid settings 
● "Ping" tab: Checking the connection to other network stations 
● "Connection Type" tab: Establishing the speed and mode of the connection 
● "PROFINET Base Functions" tab: Enter the name of the Thin Client. 

 

 
 

Note 
If the position touched on the touch screen during operation is no longer identical with the 
position evaluated by the touch screen, recalibrate the touch screen (see Section "Device 
settings (Page 79)").  
These network settings are not relevant for the SINUMERIK connection. The SINUMERIK 
connection automatically obtains its network settings from the system network. 

 

Network settings  
The following figure shows the "Settings" tab in the "Network" menu. 

 
Enter the network data of the Thin Client manually using the "Use IP parameters" option. 
You can also use the "Obtain IP address from a DHCP server" option to specify that this 
data be automatically assigned by the DHCP server. 
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Identified by 
The HMI device has three features that identify it uniquely. They define under which 
identification feature the HMI device is recognized by the DHCP server: 
● If you select "Client ID", the DHCP server identifies the HMI device on the basis of the 

host name specified in the "Client hostname" field. If configured correspondingly, the 
DHCP server searches in its configuration file for the host name and transfers the 
network settings stored there to the Thin Client. 

● If you select the most common identification parameter "MAC address", the DHCP server 
identifies the HMI device on the basis of its MAC address. 

 

NOTICE  
 

The MAC address changes when a device is replaced. The new HMI device therefore 
only obtains its previous network settings if the new MAC address is entered in the 
configuration files of the DHCP server. Otherwise communication between the server 
and the replaced HMI device is not possible. 

 

● If you select "Profinet Device name", the DHCP server identifies the HMI device on the 
basis of its PROFINET station name (see "Settings for PROFINET basic services" 
below). 

Client hostname 
You can assign a host name as the desired name for the HMI device, for example, 
"reservoir_left". This has the following advantage when an HMI device is replaced: If you 
restore the configuration file of the predecessor HMI device, the host name and thus the IP 
address remains unchanged: If you enter a DNS server of which the host name is known in 
the "DNS server" field, the host name is converted into an IP address.  
You can also activate the option "Obtain IP address from a DHCP server" with "Client ID". 

 

NOTICE  
A maximum of 63 characters is permitted. In case of connections via RDP, the host name 
will automatically be reduced to the first 15 characters at logon. 
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DNS server 
You can manually enter the IP address of the DNS server. If you activate the option 
"Obtaining DNS server address automatically", the manual IP address is overwritten by an IP 
address assigned by the DHCP server. In order for this to happen, the "Obtain IP address 
from a DHCP server" option must also be enabled. 

 

NOTICE  
No connection between client and server 
If you edit the configuration settings from an external PC, take the following into account: 
The connection can be interrupted as soon as you enter a different IP address or activate 
the "Obtain IP address from a DHCP server" option under "IP address". 
If you edit the configuration settings locally on the Thin Client, the connection with the 
configuration settings will be maintained even if you change the IP address in the 
configuration settings. 
If the "Obtain IP address from a DHCP server" option is enabled and no DHCP server is 
available, no IP address will be assigned to the Thin Client. Communication between the 
server and the Thin Client is not possible. Call the configuration settings locally on the 
Thin Client and assign an IP address that is not already used in the network to the 
Thin Client. 

 

Valid settings  
The "Status" tab in the "Network" menu always shows the network settings that are currently 
valid, regardless of whether they were assigned statically or dynamically. Use this approach 
to check whether the change in the network settings was accepted or not. 

 

Checking the connection to the server  
Under "Network > Ping" enter an IP address and check to see if this IP address is available. 

 

 Note 
Check under "Network > Ping" whether an IP address is already used on the network before 
you assign a network address statically. 

 



 Configuring the Thin Client 
 5.2 Configuration settings 

Thin Client, Thin Client PRO 
Operating Instructions, 03/2010, A5E02477571-02 61 

Establishing the speed and mode of the connection  
The Thin Client detects the data rate and the connection mode of its physical connection 
partner and matches it. A switch can also be a connection partner. You can, however, set 
the data rate and the connection mode manually. 
The following figure shows the "Connection type" tab in the "Network" menu. 

 
The automatic detection ("Autonegotiation") is enabled by default. The other parts of the 
dialog are disabled. 

 

NOTICE  
Disable the automatic detection only if the connection partner requires you to do so. 

 

If the automatic detection is not enabled, the following standard settings apply: 
● "Speed": 100 Mbps 
● "Duplex": Full 

The basic rule for establishing the speed and mode 
The connection works best if you establish one of the following combinations: 
● Automatic detection for both connection partners 
● Same speed and same mode for both connection partners 
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The following table shows the possible combinations between two connection partners. 
 
Connection partner 1 Connection partner 2 Result 
Autonegotiation 
(activated by default) 

Autonegotiation Connection partners 1 and 2 set themselves to 
100 Mbps, full duplex 
The connection works reliably. 

100 Mbps, half duplex 100 Mbps, half duplex Half duplex, late collisions 
100 Mbps, half duplex 100 Mbps, full duplex Duplex mismatch, lots of errors, no performance 
100 Mbps, half duplex Autonegotiation Connection partner 2 sets itself to 100 Mbps, half 

duplex. 
The connection works reliably. 

10 Mbps, full duplex 10 Mbps, full duplex The connection works reliably. 
100 Mbps, full duplex 100 Mbps, full duplex The connection works very reliably. 
100 Mbps, full duplex Autonegotiation Connection partner 2 sets itself to 100 Mbps, half 

duplex. 
Duplex mismatch, lots of errors, no performance 

100 Mbps, half duplex 
or full duplex 

10 Mbps, half duplex or 
full duplex 

Speed mismatch, no connection 

Settings for PROFINET basic services  
The following figure shows the "PROFINET Base Functions" tab in the "Network" menu. 

 
Under "Device name in network", establish a name for the Thin Client using which the Thin 
Client can be identified by the Administrator. This name is displayed in the title bar of the 
configuration settings and in the SIMATIC Manager as the PROFINET station name. 
Activate a PROFINET service under "Enable LLDP" (Link Layer Discovery Protocol) that 
identifies the Thin Client in the network as such. If other network components also make 
their identity known, the management station, such as a STEP7, can then recognize the 
network topology automatically. 

See also 
Configuration settings (Page 53) 
PROFINET basic services (Page 84) 
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5.2.3 Connection settings 

Introduction  
Users can connect from the Thin Client to different servers. Example: 
● Server 1: Access to WinCC messages at the plant 
● Server 2: Access to a SINUMERIK plant screen 
● Server 3: Access to office planning documents 
During remote access a client-sever connection that is defined in core by the following 
parameters is always established: 
● Connection type, called client application below, for example "Sm@rtAccess" or "RDP" 
● IP address of the server 
● Port of the server 
The Thin Client then shows the server screen depending on the server configuration.  
This section shows you how to configure the client-server connections on the Thin Client:  
● The connection settings are located in the configuration settings under "Remote". 
● The Client applications are structured in separate tabs. 
● The maximum amount of client-server connections is 30 per client application (with the 

exception of Citrix). 
● The maximum amount of client-server connections is 5 for Citrix. 

SINUMERIK 
 

 Note 
The SINUMERIK connection is configured automatically through the SINUMERIK system 
network and therefore does not have any connection settings or a connection password. 

 

Screen display 
During a SINUMERIK connection the server screen always fills the complete screen on the 
Thin Client as a full screen. In the process the server adapts its screen resolution to the 
screen resolution of the Thin Client that has the operating rights. 
All other connected Thin Clients will also display the server screen:  
● If these Thin Clients without operating rights have a lower screen resolution than the 

server, the Thin Clients scale down the server screen that is too large and display it as a 
full screen. 

● If the Thin Clients without operating rights have the same or higher screen resolution, the 
Thin Clients display the server screen reduced, centered in the original resolution. 
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Enabling and disabling client-server connections 
You enable and disable the client-server connection with the "Enabled" option. The operator 
will only see enabled client-server connections in the start bar of the selection menu. It 
makes sense to disable client-server connections in the following cases: 
● A server that is regularly used by a Thin Client is being maintained and is therefore not 

connected. 
● A second, redundant server is being set up, for the case that the first server fails. 

Factory default settings 
● Administrator password "admin" 
● IP address "192.168.1.1". 
● Some client-server connections are set up as examples with sample servers. 

 

NOTICE  
 

Misuse  
The administrator password "admin" is visible without logon. This means unauthorized 
persons may have free access to the configuration settings. 
After initial commissioning or restoring of the factory settings you should log on with 
"admin" and assign a new administrator password. 

 

NOTICE  
 

Avoiding malfunctions 
Several Thin Clients have the same default IP address. Assign an individual IP address 
to each Thin Client.  
Some client-server connections have already been created as examples. However, 
these IP addresses are only examples. Set up client-server connections with valid IP 
addresses. 
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5.2.3.1 Editing client-server connections 

Structure of the tab 
The following figure shows the "VNC/Sm@rtAccess" tab in the "Remote" menu. 

 
● Table below: Overview of client-server connections 

The table rows for the connections 1 to N are always displayed. 
● Form above: Connection data of the selected client-server connection 

The consecutive number of the client-server connection is displayed in the "Index" field.  

Buttons 
The buttons have the following functions: 
● "Copy": The connection data in the form will be copied to the cache memory. 
● "Paste": The connection data in the form will be overwritten by the connection data from 

the cache memory. 
● "Delete": All fields of the form will be deleted. 
● "Enter": The client-server connection in the form is stored under the index in the 

configuration file and, if enabled, adopted in the selection menu of the client application of 
the start bar. Subsequently the table is updated. 
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Operation 
Proceed as follows to display the connection data in the form: 
● Enter the number of the desired client-server connection under "Index" and change into a 

different field. 
● You can also click the desired client-server connection in the table. 
Proceed as follows to edit an existing client-server connection: 
1. Enter the index. 
2. Change the connection data. 
3. Touch the "Enter" button. 
Proceed as follows to create a client-server connection: 
1. Enter a free index for which no client-server connection has been entered yet (see table 

below). 
2. Enter the connection data. 
3. Touch the "Enter" button. 
Proceed as follows to copy an existing online connection: 
1. Enter the index of the client-server connection (source). 
2. Touch the "Copy" button. 
3. Enter the index of a different client-server connection or an index that is still free (target). 
4. Touch the "Paste" button. 
5. Assign a new server alias name. 
6. If necessary, change additional connection data. 
7. Touch the "Enter" button. 
The connection data of the target connection will be overwritten by the connection data of 
the source connection. 

See also 
Configuration settings (Page 53) 
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5.2.3.2 RDP 
The following figure shows the "Remote" menu, "RDP" tab.  

 
● "Fullscreen" enabled: The server screen is displayed without a window and cannot be 

moved. "Fullscreen" disabled: The server screen is displayed in a window. 
● Enter a user-specific server name at "Server alias". The alias name is then displayed in 

the selection menu of "RDP" in the start bar. When the operator selects the alias name, 
the client-server connection configured under this alias name is started. 

● You can enter a computer name or an IP address under "Server host name/IP". 
● The RDP default port "3389" is set under "Server port". 
● Enter the user domain, the user name and the password required for Thin Client logon to 

the server under "User domain", "User name" and "Password". 
● Use "EKS COM" to specify the virtual COM port that will be created on the server. EKS 

enables automatic access control via electronic keys to the server. 
For additional information see "Euchner GmbH (http://www.euchner.com)" in the 
"Products" section. 

http://www.euchner.com/�
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● Use "Persistent reconnect" to specify the Thin Client behavior in the case of a message 
that the existing connection is interrupted. If you activate this option, the Thin Client will 
try reconnecting to the server. For example you shut down the server for maintenance 
purposes. A corresponding message is sent to ten Thin Clients, for example, that 
interrupt the connection. If "Persistent reconnect" is enabled on all Thin Clients, the client-
server connection is established automatically as soon as the server is ready for 
operation again. 
If "Persistent reconnect" is disabled on all Thin Clients, the client-server connection has to 
be re-established manually on all Thin Clients.  

 

NOTICE  
 

Servers with non-server operating systems, such as Windows XP 
If a second client has established the same connection to the server, the client-server 
connection of the first client will be interrupted. Even if "Persistent reconnect" is enabled, 
the Thin Client will not try to re-establish the connection to avoid a ping-pong effect 
between the clients. 

 

● If you enable "USB storage device mapping", you can access a connected USB storage 
device on the Thin Client in the RDP connection (Windows Desktop). Data will be 
transferred to the server for this purpose and there displayed in the Windows Explorer for 
the Thin Clients. For additional information, refer to the section "Operating a USB 
memory device (Page 109)". 

 

NOTICE  
 

Security threat to the system 
The USB may infect the server with viruses, Trojans, spam, etc. 
Use a suitable virus scanner to check the data on the USB storage medium or disable 
the " USB storage device mapping" option. 
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5.2.3.3 VNC/Sm@rtAccess 
The following figure shows the "VNC/Sm@rtAccess" tab in the "Remote" menu.  

 
● Use "Client-Server connection" to enable either "VNC" or "Sm@rtAccess" as the protocol 

for the client-server connection. If you upgrade the firmware starting from an older version 
without "VNC", the client-server connections are adopted and "Sm@rtAccess" enabled 
during the migration. 
When a new client-server connection is created, "VNC" is enabled by default. 

 

NOTICE  
 

Mixed client-server connections are instable  
VNC connections to Sm@rtAccess servers and vice versa can be disconnected and are 
therefore not supported. 
Please note the following: If "VNC" is enabled, a computer name / IP address of a VNC 
server also has to be stored under "Server host name/IP". The same applies for 
"Sm@rtAccess". 

 

● With the "Fullscreen" option, toggle between the full screen display and the display in one 
window. 
– "Fullscreen" option disabled: If the screen resolution of the Thin Client is lower than 

that of the server, the server screen is displayed with scroll bars in a window that fills 
the entire screen. If the Thin Client has a higher screen resolution, the server screen is 
displayed in the original resolution in a window that fills a part of the screen. 

– "Fullscreen" option enabled: The display of the server screen fills the entire screen. If 
the screen resolution of the Thin Client is lower than that of the server, only a section 
of the server screen is displayed that fills the entire screen. This section can be moved 
by one screen width per move by moving the cursor against the respective screen 
section (bump scrolling). If the Thin Client has a larger screen resolution, the server 
screen is displayed centered in the original resolution. The remaining display is black. 

● Enter a user-specific server name at "Server alias". The alias name is then displayed in 
the selection menu of "Sm@rtAccess/VNC" in the start bar. When the operator selects 
the alias name, the client-server connection configured under this alias name is started. 
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● You can enter a computer name or an IP address under "Server host name/IP". 
● Port "5900" is set by default at "Server port". 
● Enter the password for remote access to the server at "Password". The password is 

specified when setting up VNC or Sm@rtAccess on the server. 
● Use "Persistent reconnect" (only for "Sm@rtAccess") to specify the Thin Client behavior 

in case of a message that the existing connection is interrupted. If you activate this 
option, the Thin Client will try reconnecting to the server. For example you shut down the 
server for maintenance purposes. A corresponding message is sent to ten Thin Clients, 
for example, that interrupt the connection. If "Persistent reconnect" is disabled on all Thin 
Clients, the client-server connection has to be re-established afterwards on all Thin 
Clients manually. If "Persistent reconnect" is enabled on all Thin Clients, the client-server 
connection is established automatically as soon as the server is ready for operation 
again. 

● If ""Use autoscaling" is enabled (not with VNC), the Thin Client attempts to request a 
server screen from the SmartAccess server that can be displayed as a full screen on the 
Thin Client. 
Requirements:  
– Thin Client V1.4 or higher 
– "Sm@rtAccess" option WinCC flexible 2008 SP2 or higher 
– "Fullscreen" option enabled 
If the server does not support this function, an error message will be displayed. 
Depending on the height-to-width ratio the server screen is displayed within a black bar.  
If you disable "Fullscreen", "Use autoscaling" is not available and will be disabled to avoid 
unintentional scaling of the window. 
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5.2.3.4 Citrix 
The following figure shows the "Citrix server" tab in the "Remote" menu.  

 
● Enter a name for the Citrix Presentation Server under "Server alias". The alias name is 

then displayed in the selection menu of "Citrix" in the start bar. When the operator selects 
the alias name, the client-server connection configured under this alias name is started. 

● Under "Server host name/IP" you can enter a computer name or IP address on which the 
Citrix Web Interface is located. The interface will then be addressed via the following 
address: http://<Server host name/IP>/Citrix/PNAgent/config.xml. 
The Thin Client obtains the enabled Citrix applications from the Citrix Web Interface that 
has to be installed together with a Web server on the server (see the chapter "Configuring 
a server", section "Citrix overview (Page 91)"). 

The following figure shows the "Citrix client" tab in the "Remote" menu. 

 
● With "Force fullscreen" you can force full screen display for all client server connections 

regardless of the settings on the Citrix Presentation Server. 
The administrator specifies on the server which applications are displayed in what form 
on the desktop. The full screen display results from a combination of parameters on the 
Thin Client and on the Citrix Presentation Server.  
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● If "Persistent reconnect" is enabled, the connection attempts will be unlimited: 
– If a Citrix application is selected using the Start bar, the Thin Client attempts to start 

the application continuously and without time limit. It is irrelevant if, for example, the 
network cable has been removed or the application was configured incorrectly. 

– In the case of an autostart connection, the Thin Client attempts continuously and 
without time limit to log the stored user on the Citrix Presentation Server and to start 
the application (see 1.). It is irrelevant if, for example, the network has a fault or the 
password is incorrect. 

– When an existing connection is interrupted, the Thin Client automatically tries to re-
establish the client-server connection. 

 

NOTICE  
 

When the Citrix Presentation Server is shut down, the Citrix connection will also be 
terminated on the Thin Client without additional attempts to connect. 

 

If "Persistent reconnect" is disabled, the connection attempts are limited: 
– If a Citrix application is selected using the Start bar, the attempt will be aborted after a 

failed attempt to connect. 
– In the same way the attempt is aborted after a failed attempt to connect in case of an 

autostart connection. 
– When an existing connection is interrupted, the Thin Client tries to re-establish the 

client-server connection three times for 30 seconds. Afterwards you will have to restart 
the Citrix application manually on all Thin Clients. 

If the connection attempts were aborted, the background picture will be displayed. 

5.2.3.5 Autostart connection 

Introduction 
For each client application you can identify a client-server connection as an autostart 
connection. This means that the autostart connection is established automatically after the 
Thin Client has been switched on when you have selected the client application for the 
autostart (see section "Autostart settings (Page 75)"). 
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Procedure 
Proceed as follows to identify a client-server connection as an autostart connection: 
● RDP, VNC/Sm@rtAccess: Enter a number under "default server index". The client-server 

connection with this index then becomes the autostart connection and the index in the 
table is marked green. 

● Citrix: Enter the name or IP address of the Citrix Presentation Server under "Server host 
name/IP" in the "Citrix autostart" tab. Enter the user domain, the user name and the 
password required to log on to the Citrix Presentation Server under "User domain", "User 
name" and "Password". Click "Enter" to apply the settings. 

 
Click the "Get applications" button. Select an application that is available on the Citrix 
Presentation Server. The application is then displayed as "Published application" on the 
Thin Client after the start. 

● Internet: Only one client-server connection with Web page ("Home page") is stored in the 
browser settings. 

● SINUMERIK: The system network automatically configures a SINUMERIK connection. 

5.2.3.6 Browser 

Introduction  
Enter the settings for the web browser in the "Web-Browser" tab of the "Applications" menu.  
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● Enter the address of a central connection node under "HTTP proxy" if your network 
accesses the Internet through this connection node, for example, to filter web contents or 
make them available in the cache. In case of doubt contact your system administrator. 

● Enter the internal port under which the Internet service is accessed on the proxy server 
under "Port": The default is 8080. In case of doubt contact your system administrator. 

● Enter an Internet address that should be called automatically when the web browser 
launches under "Home page" (autostart connection). 

● The proxy server will not be requested for entries that are entered under "No proxy for" 
and instead establish a direct connection. Separate several addresses by a comma (see 
"No proxy"). 

● With "Fallback charset" you specify the character set that is used by the web browser if a 
web page does not provide any information about the character set to be used. The 
character set "UTF-8" is set by default. If characters are represented incorrectly, you can 
also change to "ISO-8859-1". 

No proxy 
You can make the following entries in the "No proxy for" field: 
 
Object for which 
no proxy is to be 
used 

Content of the 
input field 
"No proxy for" 

Example Comments 

Domain Suffix of the 
domain 

".siemens.com, 
siemens.com" 

Both suffix variants must be entered in 
order to exclude an entire domain. 

Host name 
(without 
domain) 

host name only "MyWinPC" Excludes "MyWinPC. 

Host name  
(with domain) 

Host name and 
domain 

"MyWinPC.siemens.c
om" 

Excludes "MyWinPC. 

IP address IP address "192.168.1.0" Excludes the device with the IP 
address "192.168.1.0". 

Network IP address range "192.168.1.0/24" Excludes all devices with an IP 
address in the range from 
"192.168.1.0" to ""192.168.1.24"  

Placeholder characters are not permitted, e.g. "*" or "192.168.*.*". 
No entries are set as default. 
The "localhost" and "127.0.0.1" objects are always excluded. No proxy is used for these 
objects. 

See also 
Configuration settings (Page 53) 
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5.2.3.7 Connection password 

Password protection  
You can specify a password for terminating a client-server connection under "Remote > 
Session password". If the operator wants to terminate the connection to a server, he or she 
will have to enter the connection password (not for a SINUMERIK connection). If the 
operator enters an incorrect password, the connection will not be terminated. 
The length of the connection password is restricted to a maximum of 30 characters. If you do 
not specify a connection password, the operator can end any client-server connection 
without password protection. 
If a connection password has been specified, you can alternatively terminate a client-server 
connection by using the administrator password. 

Changing the password during running operation 
You can change the connection password, for example from an external PC, while the 
operator is working on the Thin Client. The change of the connection password becomes 
effective immediately. The operator can then only terminate the current client-server 
connection with the new connection password. 

5.2.4 Autostart settings 

Specifying the client application  
You specify the client application that is selected for autostart under "Applications > Autostart 
client-application". 
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After the Thin Client has been activated, the stored autostart connection of this client 
application will be started automatically. If an autostart connection is not stored for this client 
application, an error message will be displayed. The taskbar and the background picture are 
displayed.  
The SINUMERIK connection will always be started automatically. No client-server 
connections are stored for SINUMERIK. 
Click the "Enter" button to apply the changes. The changes only take effect after the HMI 
device has been restarted. A link will, therefore, take you to the restart page in Expert mode. 

No autostart 
If you have activated the "no autostart client-application" option, only the operating system 
with background picture will be displayed after the Thin Client has been switched on.  

See also 
Configuration settings (Page 53) 

5.2.5 Desktop settings 

Introduction  
The following settings can be established in the "Desktop" menu: 
● Configure the start bar. 
● Upload a background picture to the Thin Client. 
● Setting the keyboard language of the screen keyboard. 
Click the "Enter" button to apply the changes. The changes become active immediately.  

 

 Note 
Citrix symbols 
With the "Enter" button you update those symbols in the Citrix selection menu that have 
changed in the meantime on the Citrix Presentation Server. 
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Configuring the display of the start bar  
The following figure shows the "Taskbar" tab in the "Desktop" menu. 

 
 

NOTICE  
Faulty touch calibration 
If the touch screen has not been calibrated or has been calibrated improperly, you may only 
be able to open a hidden start bar by means of a connected external mouse. 
Make sure that the touch screen of your HMI device has been calibrated correctly. 

 

● "Auto-hide the taskbar" 
The start bar is hidden. To show the start bar, the operator touches the screen at the top 
or bottom margin, depending on where the start bar is latched in. The buttons to minimize 
or maximize the start bar are not displayed in the start bar. 

● "Hide the taskbar" 
The start bar is hidden. The operator cannot show the start bar. Because you cannot 
open the configuration settings on the Thin Client without the start bar, the setting "Hide 
the taskbar" can only be activated by means of an external access. 

● "Show the taskbar (minimizable)" 
The start bar is displayed when the Thin Client is switched on. The operator can minimize 
or maximize the start bar. 

 

NOTICE  
 

Auto-hide for RDP session in window mode 
If you open an RDP connection without "Auto-hide the taskbar" in window mode and 
then enable the "Auto-hide the taskbar" option, a gray bar will be shown on the screen. 
Restart the RDP connection in window mode. The desktop is shown in full on the 
screen. 
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Specify in the "Show icons" section which client applications with their connections and 
which functions are displayed in the start bar. 

Position of the start bar 
If the start bar was moved to the top margin of the screen, it will be displayed at the bottom 
margin after the following actions: 
● Storing changes in the configuration settings. 
● Saving the configuration file and restoring it. 
● Restarting the device. 

Setting up a background picture  
The following figure shows the "Background" tab in the "Desktop" menu. 

 
In the input field "Background picture upload" you can specify a file in PNG format that 
should be displayed as the background picture. Use the "Durchsuchen..." button to select a 
file. 

 

NOTICE  
Required properties of background pictures 
 Format: PNG 
 File size: max. 1.5 MByte 
 Resolution: Corresponding to the resolution of the device, maximum 1024 x 768 
 Color depth: Corresponding to the color depth of the device, maximum 64 k. 
Display of the background pictures 
The background picture is shown centered in its original size. 
Background pictures that are too large will be positioned in the top left corner of the screen.
Restoring the factory settings 
The background picture will not be restored. You can, however, download the SIMATIC 
background image from the Service&Support pages. 

 

Use the "Upload file" button to download the selected file to the server. 
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Setting the keyboard language 
The following figure shows the "Keyboard layout" tab in the "Desktop" menu. 

 
You specify the keyboard language of the on-screen keyboard and an externally connected 
USB keyboard. If you change the keyboard language during a running client-server 
connection, the change will not become active until after a restart of the client-server 
connection. 

See also 
Structure and functions of the taskbar (Page 99) 
Starting a connection (Page 101) 

5.2.6 Device settings 

Introduction  
Under "Device setup" you can establish or check the following device settings: 
● Displaying device data 
● Test hardware 
● Calibrating the touch screen 
● Update firmware 
● Save current configuration file 
● Run saved configuration file 
You can perform the following actions only from a PC that is connected to the Thin Client: 
● Update firmware 
● Save current configuration file 
● Run saved configuration file 
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You must connect the Thin Client to a PC on which the update file or the saved configuration 
file is located. You have the following possibilities of connecting the Thin Client to the PC: 
● With a cross cable directly via the LAN (PROFINET) interface 
● With a patch cable 1:1 directly via the LAN (PROFINET) interface 
● Via the server that is connected via PROFINET 

Displaying device data  
The following figure shows the "Identification" tab in the "Device Setup" menu. 

 
The device data is displayed in this tab. 

Test hardware  
Under "Hardware test" you can check the following components: 
● "Display test" 

Testing the touch screen for pixel faults. In order to change to the next test screen, tap 
the touch screen on the Thin Client. 

● "Ethernet test" 
Testing the connection. To do this, at least one Ethernet station, such as a switch, must 
be connected to the Thin Client to establish a physical connection. 

● "USB test" 
Checking the USB port. To do this, a mouse, keyboard or a USB storage device must be 
connected to the Thin Client via the USB port.  
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Calibrating the touch screen  
If the position touched on the touch screen during operation no longer complies with the 
position evaluated by the touch screen, the touch screen must be recalibrated. After you 
have started the calibration with the "Start" button in the "Touch calibration" tab, touch the 
displayed crosses on the touch screen. 
If the touch screen cannot be operated on account of an error in the calibration, you have the 
following possibilities of restarting the calibration:  
● using an external browser to call the calibration in the configuration settings of the Thin 

Client 
● using an external mouse to call the calibration on the Thin Client 
● Restoring factory settings 

Update firmware  
You update the firmware of the Thin Client only from a PC that is connected with the 
Thin Client via the network. 

 

CAUTION  
Damage to the device 
If the power supply or the connection to the PC is interrupted during the update process, 
the Thin Client will probably no longer work. 
 During the entire updating process, ensure that the power supply of the Thin Client and 

the connection to the PC is ensured. 
 Make sure that all applications running on the Thin Client are closed. 
 Before you update the firmware restart the HMI device to prevent memory problems. 
More information on updating the firmware 
Note the detailed instructions on updating to a specific firmware version on the Internet 
under "", section "Downloads". 

 

In the "Firmware update" tab use the "Browse" button to select an update file on the PC. The 
selected file is transferred from the PC to the Thin Client. To establish whether the selected 
file is suitable for the Thin Client, the system checks, for example, the following conditions: 
● The selected file is an update file. 
● The selected update file is more current than the version installed on the Thin Client. 
● The selected update file is suitable to run with this Thin Client HMI device. 
If all the conditions are fulfilled, the selected update file is executed on the Thin Client. The 
Thin Client is restarted automatically. 

 

 Note 
The progress of the update is displayed on the screen. 
If the execution of the update file is interrupted by the system on account of a fault, a log file 
is generated. You can save this log file and, if required, send it on to the Siemens technical 
support desk. 
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Saving the configuration file and then running it  
The configuration file contains all device-specific configuration settings with the exception of 
the background picture and the touch calibration. You can save the configuration file and 
then run it again later only from a PC that is connected to the Thin Client. 
● In the "Save Config" tab save the configuration file from the Thin Client to the connected 

PC. 
● In the "Restore Config" tab you can restore the saved configuration file from the 

connected PC, for example, if the current configuration file was overwritten inadvertently. 
Use the "Browse" button to select the configuration file on the PC. Use the "Upload" 
button the check the syntax within the configuration file. If the syntax is free of errors, the 
configuration file will be transferred to the Thin Client and the old configuration file will be 
overwritten; otherwise a message will be output. 
 

 

NOTICE  
 

Firmware version of the configuration file  
You can only upload a configuration file that was saved in the same firmware version as 
the one on the Thin Client. 
If you load a configuration file from an older firmware version, some functions may fail 
on the Thin Client. 
Therefore, after each firmware update, save the current configuration file to a connected 
PC. 

 

Editing the configuration file  
You can manually edit the configuration file. You can, for example, use your edited 
configuration file as a template for the configuration files for other Thin Client devices. To do 
this, edit the configuration file as required and run the edited configuration file on different 
Thin Client devices. In the case of manually assigned IP addresses, ensure that the 
configuration files with the same IP addresses are not run on different Thin Clients. 
Additional information on the structure of the configuration file is available in the product 
information "SIMATIC HMI Configuration file Thin Client 
(http://support.automation.siemens.com/WW/view/en/35105485)". 

See also 
Configuration settings (Page 53) 
SIMATIC Thin Client (http://support.automation.siemens.com/WW/view/en/23910492) 
Network settings (Page 58) 

http://support.automation.siemens.com/WW/view/en/35105485�
http://support.automation.siemens.com/WW/view/en/23910492�
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5.2.7 Settings in expert mode 

SSH configuration service  
The Thin Client is set at initial start so that you can remote configure it with the SSH 
configuration service. If you do not want to use the SSH configuration service, disable the 
option "Enable/disable the SSH configuration service" under "Expert mode > Services". 

 
 

NOTICE  
Reduced security 
Data security may not be guaranteed in case of inappropriate handling of the SSH 
configuration service. 
The SSH configuration service may only be used by qualified personnel. The persons 
considered as qualified personnel are listed in the paragraph "Qualified Personnel" on page 
2. 

 

Additional information on the SSH configuration service is available on the Internet in the 
product information "Remote configuration and remote update 
(http://support.automation.siemens.com/WW/view/en/35105474)".  

Resetting the key 
You can reset the key on the Thin Client to the default key without restoring the factory 
settings. 

 

NOTICE  
Private key 
After resetting to the default key you still need a new private key at the remote end. 
Additional information is available on the Internet in the product information "Remote 
configuration and remote update". 

 

Confirm by pressing the "Reset" button in the "SSH configuration service" section. The 
current key will be overwritten by the default key. 

http://support.automation.siemens.com/WW/view/en/35105474�


Configuring the Thin Client  
5.3 Read access to configuration settings 

 Thin Client, Thin Client PRO 
84 Operating Instructions, 03/2010, A5E02477571-02 

Duplicate IP address 
If you forget to change the default IP address, it may be possible that several HMI devices in 
the system network have the same IP address. "Duplicate IP-address detection service" 
checks if a device with the same IP address and subnet mask exists in the system network 
and to output a corresponding error message. 

Restarting the HMI device 
You initiate rebooting of the HMI device by using the "Reboot" button in the "Special 
functionality" tab. 

See also 
Configuration settings (Page 53) 

5.3 Read access to configuration settings 

Access without logon 
You can select the following tabs in the configuration settings without having logged on: 
● "Network > Status": Valid network settings of the Thin Client 
● "Device Setup > Identification": Valid device settings 
You only have read access and cannot edit the data.  

See also 
Network settings (Page 58) 
Device settings (Page 79) 

5.4 PROFINET basic services 

Introduction 
The PROFINET basic services helps to diagnose the device using standard mechanisms. 
The required diagnostics functions are available, for example, in STEP 7. 
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Functions  
As of SIMATIC Manager V5.4, SP2, the PROFINET basic services offer the following 
functions: 
● As soon as the Thin Client is connected to PROFINET, the Thin Client is shown in the 

Lifelist of the SIMATIC Manager as an available station. You can view the properties of 
the Thin Client, for example the IP address. 
Additional information from the "Target system" shortcut menu is not supported by the 
Thin Client. 

● You can assign a name and an IP address to the Thin Client under "Target system > Edit 
Ethernet stations" in the SIMATIC Manager. 

● As of SIMATIC Manager V5.4, SP4 
In the STEP7 Topology Editor of the PROFINET IO topology you can integrate and 
display the Thin Client from the catalog of passive components in topology view. 

Topology view 
Use the following functions in the topology view as of SIMATIC Manager V5.4, SP4: 
● Tabular view 

Use "Target object > Web-based management" to access the configuration settings of the 
Thin Client. 

● Graphic view 
You can insert the Thin Client in the topology. Enter the following data in the "Object 
properties:" 
– The IP address 
– The name of the Thin Client that you have specified in the configuration settings under 

"Network > PROFINET Base Functions > Device name in network". 
● Offline/Online 

The Thin Client can be located in an offline/online comparison and then displayed in the 
configured or determined topology.  

 

 
 

Note 
Version V5.4, SP4 of the SIMATIC Manager 
You will first have to run the setup file for the Thin Client for it to be displayed as a 
passive component in the topology view of version V5.4, SP4 of the SIMATIC Manager. 
The setup file PassiveComponentsInstaller.zip 
(http://support.automation.siemens.com/WW/view/en/30840898) is available on the 
Internet. Unzip the file on the PC on which STEP 7 is running with the option "Extract to" 
and then execute the .exe file. 
As of version V5.4, SP5 of the SIMATIC Manager, the Thin Client will automatically be 
displayed as a passive component in the topology view. 

 

 
 

http://support.automation.siemens.com/WW/view/en/30840898�
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Configuring the server 6
6.1 RDP 

6.1.1 RDP overview 

Introduction  
RDP, "Remote Desktop Protocol", is a protocol that the Thin Client uses to access a server 
with a Windows operating system, for example, Windows Server or Windows XP. The Thin 
Client can access all programs running on the server, if the programs have been enabled for 
remote access. The following statements for Windows XP also apply to Windows 7. 

Windows Server 2003 licensing  
You do not require any licenses on the Thin Client to access the server. You require the 
following server licenses: 
● One Windows Server license per server 
● One Windows Server Client Access License (CAL) per Thin Client 
● Also one Terminal Server Client Access License "TS Device CAL" per Thin Client, either 

– a TS Device CAL for access by any user or 
– a TS Device CAL for access by any device. 

Detailed information on licenses and applicable conditions of use are available on the 
Internet under "Windows Server 2003 Terminal Server Licensing 
(http://www.microsoft.com/windowsserver2003/techinfo/overview/termservlic.mspx)" 

Windows XP Professional licensing  
You do not require any licenses on the Thin Client to access the server. You do not require 
any additional licenses on the server for Remote Desktop. Only one screen can be operated 
for Remote Desktop with the Windows XP Professional operating systems. You can either 
operate the server monitor or the touch screen on the Thin Client. The other monitor is 
always blocked. 

http://www.microsoft.com/windowsserver2003/techinfo/overview/termservlic.mspx�
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6.1.2 Administration on the server 

Administration Windows Server 2003  
The administration on the server depends on the individual IT infrastructure. Establish the 
settings for the server configuration under the following menu commands under "Start > 
Programs > Administrative Tools:" 
● Terminal services configuration 
● Terminal services administration 
● Terminal services licensing 
You will find more information on the Internet in the "MSDN Knowledge Base" of the 
"Microsoft support (http://support.microsoft.com)". 
Specify on the server that certain users of the Thin Client can only access specified 
programs on the server. 
When configuring the Thin Client, enter a password for the connection to the server. Once 
the Thin Client has established a connection to the server, a password is usually requested 
regardless of this process. Under "Start > Programs > Administrative Tools > Terminal 
Service Configuration" you can specify that the password is not requested again. 

Administration Windows XP Professional  
The following statements for Windows XP also apply to Windows 7.  
To enable Thin Client access to the server, you must enable remote access on the server. 
You can enable remote access under "Start > Settings > Control Panel > System > Remote" 
with the option "Allow users to establish a remote desktop connection." Use the "Select 
remote users" button to open a dialog in which you select the users that are authorized to 
access the server. 
In addition, you enable the server ports that have been set for remote access in the firewall. 

Keyboard language with Windows XP Professional  
The Thin Client is available with a German and an English screen keyboard. Set the 
keyboard language on the Thin Client so that it matches the keyboard language on the 
server. If the keyboard language on the Thin Client and the server do not agree, the keys 
pressed on the Thin Client keyboard will not be interpreted correctly by the server. 

http://support.microsoft.com/�
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Configuring double-click 
If it is too difficult to double-click the touch screen with your finger or the touch stylus, then 
make the setting in Windows Explorer on the server that files and folders should open with a 
single click under "Tools > Folder options > General > Selecting elements". 
You have the option to establish a greater range in which two clicks can be detected as a 
double-click under [HKEY_CURRENT_USER\Control Panel\Mouse] in the Windows registry 
of the server. Under "DoubleClickHeight" and "DoubleClickWidth" enter 10 pixels, for 
example. 

6.2 VNC 

Introduction 
Use VNC for remote control of another computer via a network. VNC is the abbreviation for 
"Virtual Network Computing" and shows the desktop of another computer. In contrast to RDP 
all clients will display the same server screen. 

Requirement 
The operating system you use does not play a role because the software is available for all 
current platforms. The connection via the network uses the TCP/IP protocol and and should 
be configured with a password for security reasons. 

Structure 
VNC works according to the client-server model. The program consists of the server module 
VNC server and the client component VNC Viewer. The server program runs on the 
computer whose screen outputs you want to monitor, whereas the clients receive the screen 
outputs and in turn send keyboard and mouse inputs to the server. 
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6.3 Sm@rtAccess 

Introduction 
With the Sm@rtAccess option the HMI devices are able to communicate with each other via 
PROFINET. Sm@rtAccess hence enables client / server configurations for distributed 
operator stations in a system. 
If the Sm@rtAccess option is installed on an HMI device, for example on an MP 377, the 
Thin Client can access the running project via Ethernet. In this case, the HMI device is the 
server. The Thin Client is a client. 
A description of the Sm@rtAccess configuration can be found in the online help of WinCC 
flexible or in the "WinCC flexible Getting Started Options" manual. 

Sm@rtAccess-capable HMI devices 
The Sm@rtAccess option can be used for all HMI devices as of device class 177B PN. You 
can refer to the documentation of your HMI device regarding the number of clients that are 
possible with an HMI device that is used as a server. 

Licensing 
You do not require any licenses on the Thin Client in order to access an HMI device. The 
licenses are included in the Sm@rtAccess option. The Sm@rtAccess license must be 
installed on the HMI device on which you are accessing the Thin Client. 
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6.4 Citrix 

6.4.1 Citrix overview 

Introduction 
Citrix provides central access to all company applications as an on-demand service for all 
types of end devices at all company locations. This may take place in form of hosted 
applications that are executed on a server in the company data processing center. Rollouts 
of new applications, updates and patches are thus available immediately to all users. 

Requirement 
● Citrix Presentation Server: You set up desktops and Citrix applications on the server that 

you authorize for specific users. 
● Citrix Web Interface: The Thin Client obtains the authorized Citrix applications from the 

Citrix Web Interface 
● The Citrix Web Interface requires a web server, such as the Internet Information Server 

(IIS) from Microsoft. 

Citrix Presentation Server 
The product line Citrix XenApp V5.0 and higher is called "Citrix Presentation Server" in the 
documentation up to V4.5. It currently encompasses four powerful editions that are tailored 
to different company requirements. 
Additional information is available in the documentation for Citrix XenApp on the Internet 
under www.citrix.de (http://www.citrix.com/lang/English/home.asp). 

See also 
Citrix (Page 71) 

6.4.2 Configuring the Citrix Web Interface 

Introduction 
In the following section you set up a web site from which the Thin Client obtains the 
authorized Citrix applications via the Citrix Web Interface. 

http://www.citrix.com/lang/English/home.asp�
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Procedure 
Proceed as follows to set up the web site: 
1. Start the "Citrix Access Management Console". 
2. Select the entry "Create site" in the shortcut menu "Citrix Resources > Configuration 

Tools > Web Interface". A wizard is started. 

 
3. Select the "Program Neighbourhood Agent Services site" option in the "Create Site Type" 

dialog box. 
4. Follow the instructions on the screen and configure the PNA service according to your 

operating environment. 
5. Enter "http://<Server host name/IP>/Citrix/PNAgent/config.xml" as the address of the 

PNA service. The Thin Clients access the Citrix Server through this URL (see the chapter 
"Connection settings", section "Citrix (Page 71)"). 

 

NOTICE  
 

Proxy server 
Do not use a proxy server for access to the Citrix Web Interface through the PNA 
Service address. 

 

Proceed as follows to set the authentication method: 
6. Select the "Remote" option in the "Select Application Type" dialog box. 
7. Use the "Finish" button to terminate the wizard. 
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8. Select the "Configure authentication methods" entry in the shortcut menu of "config.xml". 

 
9. Several options are displayed as authentication methods. Select at least the 

authentication method "Prompt". 
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6.5 SINUMERIK 

Introduction 
The DHCP server is enabled on each SINUMERIK server by default. The SINUMERIK 
system network therefore configures itself dynamically via the DHCP protocol. Additional 
information is available in the "SINUMERIK manual "Operator components and networking" 
(6FC5397-1AP10-5AA0) (http://www.automation.siemens.com/doconweb/)". 

USB stick for commissioning 
In the HMI user interface of the SINUMERIK TCU you use a button to access the USB port 
on the back of the Thin Client. You may, for example, read in the series commissioning files 
from the SINUMERIK USB stick. A maximum of one USB storage device is accessed which 
is recognized first. 

 

NOTICE  
Security threat to the system 
The USB may infect the server with viruses, Trojans, spam, etc. 
Use a suitable virus scanner to check the data on the USB storage medium or disable the 
HMI button for access via USB. 

 

The USB port is only available if you make the following settings for the corresponding 
button in the SINUMERIK menu "Commission > HMI > Logical drive": 
● "Type" = "USB local" 
● "Connection" = "X204" 

http://www.automation.siemens.com/doconweb/�
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Operating the Thin Client  7
7.1 Overview 

Introduction 
The monitor screen of the server is output to the screen of the logged on Thin Client. You 
operate the server screen from the Thin Client. 

Operator input options 
The following operator control options are available, depending on the peripherals that are 
connected to your Thin Client: 
● Touch screen 

You activate operating elements by touching them with your finger. 
To double-click them, touch an operating element twice in succession. The server can be 
configured for opening folders and files with a single click. 

● External keyboard, connected via USB 
● External mouse, connected via USB 

Unintentional actions  
 

WARNING  
Unintentional actions 
Always touch only one operating element on the screen Otherwise, you may trigger 
unintentional actions.  

 

On-screen display for remote access to a server 
The server screen is displayed either in full screen or in window mode, depending on the 
Thin Client configuration. The display mode also depends on whether the server screen has 
the same resolution as the Thin Client screen. Additional information is available in the 
configuration settings, Section "Connection settings (Page 63)". 

Monitoring mode  
If you access an HMI device on which monitoring mode has been configured for 
Sm@rtAccess, you can only monitor the HMI device; you cannot intervene for control 
purposes. 
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Operating right  
When you access an HMI device, it is possible that this HMI device is being used. In this 
case, the Thin Client does not have operating rights.  
When you touch the screen, a message is displayed stating that operation is not possible. 
How you request or force operating rights depends on the configuration on the HMI device 
you are accessing with the Thin Client. 
At the SINUMERIK connection you request operating rights by tapping the touch screen. 

7.2 Interrupting and restoring a connection 

Introduction  
The connection to the server can be interrupted by different methods: 
● The server is offline or has has not completed its startup sequence. 
● The password is incorrect. 
● A firewall is blocking server access. 
● SINUMERIK: Firmware on the server is older than 2.6 SP1. 
● The server will be shut down, for example, for maintenance purposes. 
● The PROFINET network cable was disconnected. 
● A connection problems occurred in the network. 
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Standard Reconnect 
The HMI device tries to re-establish the interrupted connection automatically. There are two 
basic default options:  
● Initial start of a connection 

The connection cannot be established because the server is not ready, for example. The 
Thin Client attempts continuously to reconnect to the server. 

● Existing connection 
An existing connection to the server is interrupted because the network cable has been 
removed or the network is faulty, for example. 
The Thin Client attempts continuously to reconnect to the server.  
Exception: When the Thin Client receives a message via the network, for example when 
the server is shut down, the Thin Client terminates the current client-server connection. 
Afterwards the Thin Client only tries to re-establish the interrupted connection to the 
server, if the "Persistent reconnect" option is enabled in the configuration settings. 

Proceed as follows to stop the connection attempts: 
1. Terminate the current connection. 

To do so, press the icon of the connection in the start bar. 
2. Select the menu command "Close". 

The connection is terminated. 

Special features 

Citrix 
Exact information about the connection behavior is available in the connection settings in the 
section "Citrix (Page 71)" under the "Persistent reconnect" option. 

SINUMERIK 
Initial start of a connection: Maximum of 40 connection attempts. Afterwards the background 
picture is displayed. 
Existing connection: No Standard Reconnect. After the connection has been aborted, the 
message "Waiting for HMI" is displayed. 

 

 Note 
The "Menu" button is then used to access the SINUMERIK service menu. If a keyboard is 
connected, the button will be hidden. Then press the key combination <F9>+<F10>. 
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7.3 Front operator controls 

Thin Client Touch  

 
① Display with touch screen 

The Thin Client is operated with the touch screen. All operator controls required for operation 
are displayed on the touch screen once the HMI device has started. 

Note when operating 
 

CAUTION  
Damage to the touch screen  
The following operation reduces the service life of the touch screen considerably up to a 
total failure: 
 Touching it with a pointed or sharp object 
 Abrupt impact with solid objects 
Always operate the HMI touch screen with your fingers or with a touch pen.  

 

See also 
Design of the Thin Client Touch (Page 12) 
Design of the Thin Client Touch (Page 12) 
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7.4 Operating the taskbar 

7.4.1 Structure and functions of the taskbar 

Display with "Show the taskbar"  
If the option "Show the taskbar" is enabled in the configuration settings of the Thin Client, the 
start bar will be displayed after switching on the HMI device.  
The following figure shows the start bar. 

 
Various icons for the individual client applications are displayed on the left-hand side of the 
start bar. An icon, for example "RDP", is only displayed if at least one client-server 
connection has been defined and enabled.  
When you click an icon, a selection menu is displayed with all the enabled client-server 
connections of the client application. The start bar remains visible when you call up a client-
server connection.  
You can modify the view and position of the start bar. 

● You minimize the start bar with the  symbol. 

● You maximize the start bar with the  symbol. 

● You can move the start bar to the top or bottom margin of the screen. 
The start bar can be moved only when it is maximized. 
Drag the start bar to the edge of the screen with your finger or, if connected, with the 
external mouse.  

Display with "Auto-hide the taskbar"  
If the option "Auto-hide the taskbar" is enabled in the configuration settings of the 
Thin Client, the start bar is not displayed until you touch the screen in the upper or lower 
margin. The buttons to minimize or maximize the start bar are not displayed. 

Display with "Hide the taskbar"  
If the option "Hide the taskbar" is enabled in the configuration settings of the Thin Client, 
then the start bar will be hidden completely and cannot be shown. 

 

 Note 
If the administrator saves changes in the configuration settings, the position of the start bar 
may be changed. If the start bar was moved to the top margin of the screen, it will be 
displayed at the bottom margin. 
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Calling functions 
The following functions can be called from the start bar. 

 Configuration settings 
Configure the Thin Client in the configurations settings. 

 Screen keyboard 
Use the screen keyboard to enter alphanumeric values, special characters and function key 
commands. The screen keyboard is automatically opened in a minimized state when the 
Thin Client is switched on.  

 Right mouse button 
If you press the "right mouse button" button, then the next touch on the touch screen will be 
interpreted as a right click. 

 Blocking the touch screen 
Use the function "Blocking the touch screen" to block the touch screen for 15 seconds, for 
example to clean the screen. 

 Restart 
Use the "Restart" function to restart the HMI device, for example, to test the autostart 
settings. The "Restart" icon is hidden by default. Show the icon in the Desktop settings 
(Page 76) or use the restart page in the Settings in expert mode (Page 83). 

See also 
Disabling the touch screen (Page 112) 
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7.4.2 Starting a connection 

Overview 
You establish a connection from a Thin Client to a server with the following client 
applications: 

 RDP: A selection menu with the activated client-server connections is displayed. 

 Sm@rtAccess/VNC: A selection menu with the activated client-server connections is 
 displayed. 

 Citrix: The logon dialog for the Citrix Presentation Server will be displayed. 

 SINUMERIK: A selection menu with the "Open" command will be displayed.  

 Web browser: The web browser opens with the connection settings that you have 
 defined in the configuration settings. 

 

NOTICE  
Only one connection is possible at any given time  
If you start a different client-server connection using the start bar, the current connection 
will be terminated and a new connection to the selected server will be established. 
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Procedure for RDP, VNC/Sm@rtAccess  

 
① Client application 
② Selection menu with the groups Sessions 01-10 
③ Enabled client-server connections, sorted by number 

Proceed as follows: 

1. Touch the corresponding icon "RDP" or "Sm@rtAccess/VNC" ①. 

The selection menu will open. 

2. Select the group ② that contains the required client-server connection. 

An additional menu is opened. 

3. Select the required client-server connection ③. 

The connection to the server will be started. 

VNC/Sm@rtAccess 
"VNC/m@rtAccess" contains the information for every client-server connection whether it is 
a Sm@rtAccess or a VNC connection (see connection settings, Section "VNC/Sm@rtAccess 
(Page 69)"). 
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Procedure for SINUMERIK  

 
Proceed as follows: 
1. Touch the "SINUMERIK" icon. 

The selection menu will open. 
2. Select the menu command "Open". 

The Thin Client connects to the SINUMERIK system network.  
The automatic assignment of the IP address is activated temporarily in the network settings. 
The SINUMERIK Bootloader briefly displays the IP address of the server currently 
connected. 
The SINUMERIK server downloads the SINUMERIK Viewer with configuration file to the 
Thin Client. Afterwards the SINUMERIK user interface is displayed on the Thin Client. For 
additional information on operation and authorizations refer to the documentation 
"SINUMERIK manual "Operator components and networking"  
(MLFB: 6FC5397-1AP10-4AA0) (http://www.automation.siemens.com/doconweb/)". 

 

 Note 
TCU service menu 
During an existing connection you can access the TCU service menu by using the menu 
command "Settings" or, if "Waiting for HMI" is displayed on the screen, by using the "Menu" 
button. In both cases you can also use the key combination <F9>+<F10> to access the TCU 
service menu if a keyboard is connected. 

 

http://www.automation.siemens.com/doconweb/�
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Procedure for Citrix 

 
Proceed as follows: 
1. Touch the "Citrix" icon. 

The selection menu will open. 
2. Select the menu command "Logon". 

The "Citrix Login Form" dialog box opens. 

 
3. Select an enabled client-server connection under "Server". 
4. Log in under a domain with your user name and password. 
5. Close the dialog box with the "OK" button. The user-specific login data are stored for the 

next login, but without the password. 
Wait until the message "Login successful!" is displayed. When you then touch the "Citrix" 
icon in the start bar, the Citrix selection menu with the authorized applications and 
submenus will be displayed. 

6. Select the required application. 
The application will start and the message "Please wait while launching application" is 
displayed briefly. It may then still take some time until the application is displayed. 
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If the connection cannot be established, a separate dialog box is displayed for each error 
message. Close all open dialog boxes in reverse order. 
In an open application, for example "Desktop", you can open additional applications, such as 
"Explorer". 

 

 Note 
Updating the selection menu 
Use the "Reload applications" menu command to update the selection menu after new 
applications have been authorized on the Citrix Presentation Server. The modified 
applications will be available when the message "Please wait while reloading applications..." 
disappears. Modified icons, however, have to be updated separately, see Section "Desktop 
settings (Page 76)". 
Supported functions 
All icons and applications of the Citrix Presentation Server, for example "Citrix Streams", are 
displayed in the selection menu. "Shared applications" and "shared content" will be 
supported. 
To open and display "shared content", the Administrator has to authorize a corresponding 
application as a "shared application". Additional information is available in the Citrix 
documentation on the Internet under www.citrix.de 
(http://www.citrix.com/lang/English/home.asp). 

 

7.4.3 Terminating a connection 

Introduction 
Proceed as follows to terminate a client-server connection: 
● By using the "Close" menu command (see below). 
● When you start a different client-server connection (see Section "Starting a connection 

(Page 101)"), the current connection will be terminated as with the "Close" menu 
command. 

● For more options refer to "Special features". 

http://www.citrix.com/lang/English/home.asp�
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Procedure 
Proceed as follows to terminate the current client-server connection: 
1. Touch the corresponding icon of the client application. 

The selection menu will open. 
2. Select the menu command "Close". 
3. If required, enter the connection password (see Section "Connection password 

(Page 75)"). 
 

NOTICE  
 

Misuse  
RDP can be set on the server so that the user stored in the connection settings remains 
logged in even after an RDP connection has been terminated.  
After a Citrix connection has been terminated, the user who logged in the login dialog 
box remains logged in.  
Make sure that only authorized persons have access to the device or log off (see 
Special features). 

 

Special features 

RDP 
 

 Note 
Terminate the RDP connection alternatively by using "Start" > "Disconnect". The "RDP 
session has been terminated by peer!" dialog box will be displayed on the Thin Client; 
acknowledge it with "OK". The connection password is not requested. 
You log off from the RDP server with "Start" > "Logoff". 

 

Citrix 
After a Citrix connection has been terminated with the "Close" menu command, the 
application started on the Thin Client remains saved on the server. When the user logs in 
again and the application starts, work can be continued in the application at the same point. 
The administrator of the Citrix Presentation Server can change this behavior.  
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You can also close the application directly on the server: In the title bar click the "Cross" icon 
or select the corresponding menu command for closing in the menu bar.  

 

NOTICE  
Connection password without effect  
If you close all open applications by using their title or menu bars, Citrix will be terminated 
without a password prompt. 

 

Proceed as follows to log off Citrix: 
1. Touch the "Citrix" icon. 

The selection menu will open. 
2. Select the menu command "Logoff". 
Logging off from Citrix has the following effects: 
● The open application and, if required, additional applications opened by it will continue 

running. 
● The active application disappears from the selection menu. 
● The user is logged off from the Citrix Presentation Server. 

SINUMERIK 
The connection to the SINUMERIK system network is terminated. The network settings are 
reset to the values they had before the SINUMERIK connection was started. 
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7.5 Operating the screen keyboard 

Screen keyboard  
If you have not connected an external keyboard to the Thin Client, use the screen keyboard 
for entries, e.g. in the configuration settings. The screen keyboard is automatically opened in 
a minimized state when the Thin Client is switched on. 
If you activate an IO field when accessing a WinCC flexible or WinCC project on a server, 
the screen keyboard is displayed automatically. 

 

 Note 
Setting the focus on the application 
Note that after moving the screen keyboard, the focus must again be set to the application 
program, if entries are to be carried out on it. 
Screen keyboard 
The Thin Client is available with a German and an English screen keyboard. If you access a 
server with the Windows XP or Windows 7 operating system using the "RDP" protocol, set 
the keyboard language on the Thin Client so that it is identical to the keyboard language on 
the server. If the keyboard language on the Thin Client and the server do not agree, the keys 
pressed on the Thin Client keyboard will not be interpreted correctly by the server. 

 

Operating the screen keyboard 
The following figure shows the screen start bar. 

 
You operate the screen keyboard by directly touching the keys of the keyboard on the touch 
screen. The functions of the keys on the screen keyboard are the same as those on an 
external keyboard. You can move the screen keyboard with your fingers. 
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"Shift" key  
The "Shift" key is always enabled only for the next key press on the screen keyboard. If you, 
for example, wish to enter several uppercase letters one after the other, you must press the 
"Shift" key before each character. 
Alternatively, you can lock the "Shift" key by pressing the "Caps Lock" key. 

Input focus  
Several windows can be open in an application. You can establish for which window the 
following input via the screen keyboard is valid as follows: 
● you touch the desired window on the touch screen. 
● You use an external mouse to click in the desired window. 
If the focus is to be established on the desired window not as described above, press the 
"Focus" key on the screen keyboard and then select the desired window on the touch 
screen. 

Number pad 
The screen keyboard does not have a separate number pad. If you have connected an 
external keyboard, you cannot make any entries via the number pad of the external 
keyboard.  

"xvkbd" key 
Use the "xvkbd" key to call the information about the author and the licensing of the "xvkbd" 
screen keyboard.  

7.6 Operating a USB memory device 

Introduction 
Use the USB port on the back of the device to access connected USB storage devices. 

RDP 
In the case of an RDP connection you have read and write access to one or several USB 
storage devices. 
With active RDP connection the USB storage devices are exported to the RDP server. A 
folder with the name "media on <Client hostname>" is created in Windows Explorer, in which 
a separate subfolder is displayed for each USB storage device. When you change the host 
name in the configuration settings of the Thin Client, the name of the folder is adapted 
automatically on the RDP server. 
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Requirement 
● The option "Map USB storage device" is activated in the configuration settings under 

"Remote > RDP". 

SINUMERIK 
In case of a SINUMERIK connection you have read and write access to the folder structure 
of a single (the first) USB storage device through an HMI button. Further information is 
available on the Internet at SINUMERIK manual "Operator components and networking" 
(MLFB: 6FC5397-1AP10-4AA0) (http://www.automation.siemens.com/doconweb/). 

Requirement 
● The USB port is enabled in the HMI, see Chapter "Configuring a server", Section 

"SINUMERIK (Page 94)". 

Removing a USB memory device 
Proceed as follows: 
1. Make sure the device is no longer being accessed. To do so, select a different drive, 

close the Windows Explorer or exit the application accessing the device. 
2. Wait for 5 to 10 seconds. 
3. Remove the USB memory device from the USB port of the Thin Client. 

See also 
Connecting a USB device (Page 49) 
RDP (Page 67) 

7.7 Performance data 

Performance values 
The performance depends on the network capacity in your system. With Sm@rtAccess the 
performance moves within the scope of the values that have been specified in the 
WinCC flexible documentation. 
Example values for the performance are available on the Internet under "FAQ 25576569 
(http://support.automation.siemens.com/WW/view/en/25576569)". 

http://www.automation.siemens.com/doconweb/�
http://support.automation.siemens.com/WW/view/en/25576569�
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Maintenance and care 8
8.1 Maintaining and caring for the touch screen. 

Introduction  
The HMI device is designed for maintenance-free operation. You should clean the touch 
screen at regular intervals, however. 

Requirement 
● Damp cleaning cloth 
● Washing up liquid or foaming screen cleaning agent 

Procedure 
 

WARNING  
Unintentional response  
If you clean the touch screen while it is switched on, you could cause malfunctions. 
Switch off the HMI device or - if running - clean the touch screen only in a blocked state. 
Note that the touch screen block automatically ends after 15 seconds. 
Damage caused by unauthorized cleaning products  
You damage the HMI device when you use compressed air, steam cleaners, aggressive 
solvents or scouring powder. 
Do not clean the HMI device with compressed air or steam jet blowers. Do not use 
aggressive solvents or scouring powder. 

 

Proceed as follows: 
1. Switch off the HMI device or block the touch screen. 
2. Spray the cleaning solution onto a cleaning cloth. 

Do not spray directly onto the HMI device. 
3. Clean the HMI device. 

When cleaning the display wipe from the screen edge inwards.  
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8.2 Disabling the touch screen 

Cleaning  
The HMI touch screen can be cleaned when it is switched on and a project is running. To do 
this you must block the touch screen. 

 

WARNING  
Unintentional response 
If you clean the touch screen while it is switched on, you could cause malfunctions. 
Switch off the HMI device or - if running - clean the touch screen only in a blocked state. 
Note that the touch screen block automatically ends after 15 seconds. 

 

Procedure  
Proceed as follows: 

1. Block the touch screen using the  symbol in the start bar. 
2. Cleaning the touch screen. 

After 15 seconds the block is automatically lifted. 

3. If you wish to continue cleaning, you must again press the  symbol in the start bar. 

8.3 Spare parts and repairs 

Repairs  
If the unit needs to be repaired, you will have to ship the HMI device to the Return Center in 
Fürth. The address is:  
Siemens AG 
Industry Sector 
Returns Center 
Siemensstr. 2-4 
90766 Fürth 
Germany 
For additional information, refer to the Internet at "Spare parts and repairs 
(http://support.automation.siemens.com/WW/view/en/16611927)". 

Spare parts  
Spare parts and accessories for the HMI devices can be found in chapter Accessories 
(Page 19). 

http://support.automation.siemens.com/WW/view/en/16611927�
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Technical specifications 9
9.1 Dimension drawings 

The HMI device Thin Client 10" Touch is available in two enclosure models with different 
product versions. The product version is indicated on the back of the HMI device. 

Dimension drawings of the Thin Client 10" Touch  
Dimension drawing of the Thin Client 10" Touch up to and including product version 06: 
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Dimension drawing of the Thin Client 10" Touch as of product version 15: 
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Dimension drawings of the Thin Client 15" Touch  
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Dimension drawings of the Thin Client PRO 15"  
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Dimension drawings of the basic adapter  
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9.2 Specifications 

HMI device 
 
 Thin Client 10" Touch Thin Client 15" Touch Thin Client PRO 15" 
Weight without packaging c. 2 200 g c. 3 560 g c. 6 500 g, 

with basic adapter c. 6 900 g 

Display 
 
 Thin Client 10" Touch Thin Client 15" Touch, 

Thin Client PRO 15" 
Type LCD TFT 
Display area, active 211.2 mm x 158.4 mm (10.4") 304.1 mm x 228.1 mm (15") 
Resolution 640 x 480 pixels 1024 x 768 pixels 
Colors, displayable 64 k 
Brightness control No 
Backlighting 
Half brightness life time, typical 
Meantime Between Failure (MTBF) 

CCFL 
50 000 h 
50 000 h 

Input device 
 
 Thin Client 10" Touch Thin Client 15" Touch 

Thin Client PRO 15" 
Type Touch screen, analog, resistive 

Interfaces 
 
 Thin Client 10" Touch Thin Client 15" Touch 

Thin Client PRO 15" 
1 x USB 1.1  USB host; conforms to USB standard 1.1 (supporting low-speed USB devices) 

 Maximum load 100 mA 

1 x LAN: Ethernet/PROFINET (X1) RJ45 10/100 Mbps 
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Supply voltage 
 
 Thin Client 10" Touch Thin Client 15" Touch 

Thin Client PRO 15" 
Rated voltage 
Range, permissible 

+24 VDC 
19.2 V to 28.8 V (± 20 %) 

+24 VDC 
19.2 V to 28.8 V (± 20 %) 

Transients, maximum permissible 35 V (500 ms) 35 V (500 ms) 
Time between two transients, 
minimum 

50 s 50 s 

Current consumption 
 Typical 
 Constant current, maximum 
 Power on current surge I2t 

 
 c. 500 mA 
 c. 1 100 mA 
 approx. 1 A2s 

 
 c. 700 mA 
 c. 1 100 mA 
 approx. 1 A2s 

Fuse, internal Electronic Electronic 

9.3 Description of the ports 

9.3.1 Power Supply 
Plug connector, 2-pin 

 
The following table shows the pin assignment of the power supply. 
 

Pin Assignment 
1 +24 VDC 
2 GND 24 V 
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9.3.2 USB 
USB socket 

 
The following table shows the pin assignment of the USB port. 
 

Pin Assignment 
1 +5 VDC, out (max. 100 mA) 
2 USB-DN 
3 USB-DP 
4 GND 

9.3.3 LAN (PROFINET) 
RJ45 plug connector, X1 

 
The following table shows the pin assignment of the RJ45 connector. 
 

Pin Assignment 
1 TX+ 
2 TX- 
3 RX+ 
4 n.c. 
5 n.c. 
6 RX- 
7 n.c. 
8 n.c. 
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Appendix A
A.1 ESD guideline 

What does ESD mean? 
An electronic module is equipped with highly integrated electronic components. Due to their 
design, electronic components are highly sensitive to overvoltage and thus to the discharge 
of static electricity. Such electronic components are labeled as electrostatic sensitive devices 
(ESD). 
The following abbreviations are commonly used for electrostatic sensitive devices: 
● ESD – Electrostatic Sensitive Device 
● ESD – Electrostatic Sensitive Device (internationally recognized term) 

Electrostatic charge  
 

CAUTION  
Electrostatic charge 
ESDs may be destroyed by voltages far below the level perceived by human beings. If you 
are not discharged electrostatically, the voltage that you transfer when touching a 
component or the contact points of a module can already cause damage. 
The damage to an ESD caused by overvoltage is usually not recognized immediately. The 
damage only becomes apparent after a long period of operation. 
Discharge any electrostatic charge of your body before you touch the ESD. 

 

Anyone who is not connected conductively to their surroundings is subject to electrostatic 
charge. 
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The following diagram shows the maximum voltage values to which a person can be 
charged electrostatically. The values depend on the material and humidity. The shown 
values are in conformity with the specifications of EN 61000-4-2. 

 
① Synthetic materials 
② Wool 
③ Antistatic materials such as wood or concrete 

Protective measures against discharge of static electricity  
 

CAUTION  
Grounding measures 
There is no equipotential bonding without grounding. An electrostatic charge is not 
discharged and may damage the ESD. 
When working with electrostatic sensitive devices, make sure that the person and the 
workplace are properly grounded. 

 

Note the following: 
● Only touch the ESD if it is absolutely necessary. 
● When you touch ESD modules, avoid touching the pins or the PCB tracks. 

This precaution reduces the risk of damaging an ESD. 
● Discharge electrostatic electricity from your body if you are performing measurements on 

an ESD. 
To do so, touch a grounded metal object before you carry out the measurement. 

● Always use grounded measuring instruments. 
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Abbreviations B
 

 
CAL Client Access License (Windows Server) 
DC Direct Current 
DHCP Dynamic Host Configuration Protocol 
DNS  Domain Name System 
DP Distributed I/O 
ESD Components and modules endangered by electrostatic discharge 
EMC Electromagnetic Compatibility 
EN European standard 
ESD Components and modules endangered by electrostatic discharge 
GND Ground 
HF High Frequency 
HMI Human Machine Interface 
HTTP Hypertext Transfer Protocol 
IEC International Electronic Commission 
IP Internet Protocol 
MAC Media Access Control 
MPI Multipoint Interface (SIMATIC S7) 
MS Microsoft 
MSDN Microsoft Developer Network 
OP Operator Panel 
PC Personal Computer 
PPI Point-to-Point Interface (SIMATIC S7) 
PELV Protective Extra Low Voltage 
PN PROFINET 
RDP Remote Desktop Protocol 
RJ45 Registered Jack Type 45 
TFT Thin Film Transistor 
TP Touch Panel 
TS-CAL Terminal Server Client Access License (Windows Server) 
UL Underwriter’s Laboratory 
USB Universal Serial Bus 
VNC Virtual Network Computing 

 
 



Abbreviations  
  

 Thin Client, Thin Client PRO 
124 Operating Instructions, 03/2010, A5E02477571-02 



 

Thin Client, Thin Client PRO 
Operating Instructions, 03/2010, A5E02477571-02 125 

Glossary 

Browser 
A browser is a computer program that is used to start Web sites in the Internet. 

Client-server system 
A client/server system is a network structure in which the resources are offered by a central 
server that the workstations (clients) can access. 

Degree of protection 
The degree of protection specifies the suitability of electronic equipment for a variety of 
ambient conditions – and the protection of persons against potential danger when using this 
equipment. 
The degree of protection specified by IP differs from the protection class. But both involve 
protection against touching dangerous electric voltage. The degree of protection also 
classifies the protection of equipment against dirt and moisture. 

Domain Name System (DNS) 
The DNS is a service in the Internet that converts domain names into IP addresses. 

Dynamic Host Configuration Protocol (DHCP) 
DHCP enables dynamic assignment of an IP address and additional configuration 
parameters to computers in a network, via an appropriate server. 

Electromagnetic Compatibility (EMC) 
Electromagnetic compatibility (EMC) refers to a usually desirable state, in which technical 
equipment does not disturb one another with unwanted electrical or electromagnetic effects. 
Electromagnetic compatibility deals with technical and regulatory questions of undesired, 
mutual influence in electrical engineering. 

EMC 
Electromagnetic compatibility is the ability of electrical equipment to function properly in its 
electromagnetic environment without influencing this environment. 

Ethernet 
Ethernet is a fixed-cable data network technology for local area networks (LANs). Ethernet 
enables data transfer in the form of data frames between all devices that are connected in a 
local area network, for example, computers, printers.  

HMI device 
An HMI device is a device used for the operation and monitoring of machines and plants. 
The statuses of the machine or plant are indicated by means of graphic elements or by 
indicator lamps on the HMI device. The operator controls of the HMI device allow the 
operator to interact with the processes of the machine or plant.  
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Plant 
General term referring to machines, processing centers, systems, plants and processes 
which are operated and monitored on an HMI device. 

PLC 
A PLC is a general term for devices and systems with which the HMI device communicates, 
for example, SIMATIC S7. 

Process visualization 
Visualization of technical processes by means of text and graphic elements. Configured 
plant screens allow operator intervention in active plant processes by means of the input and 
output data. 

PROFINET 
PROFINET is a standard for an industrial Ethernet in automation systems. 

Project 
Result of a configuration using a configuration software. The project normally contains 
several screens with embedded system-specific objects, basic settings and alarms. The 
project is transferred to an HMI device and monitored and operated with the HMI device. 

Protection class 
The protection class is used in electrical engineering to classify and identify electrical 
equipment in relation to existing safety measures designed to prevent electric shock. There 
are four protection classes for electrical equipment. 

Remote Desktop Protocol (RDP) 
RDP enables network access to applications that are executed on a Windows Terminal 
Server. In this process the RDP regulates transmission of screen content and keyboard and 
mouse inputs over the network. 

Screen 
Form of the visualization of all logically related process data for a plant. The visualization of 
the process data can be supported by graphic objects.  

Sm@rtAccess 
The Sm@rtAccess option enables communication between HMI systems based on Ethernet 
networks or via the Intranet/Internet. This enables an HMI device to be monitored and 
remotely controlled by another HMI device. 

Virtual Network Computing (VNC) 
VNC enables network access to applications that are executed on a remote computer 
regardless of the platform. In this process the VNC controls transmission of screen content 
and keyboard and mouse inputs over the network. 
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Index 

A 
Abbreviation, 123 
Accessory kit, 18 
Administrator, 3 
Administrator password, 54 
Administrator password: forgetting, 57 
Application scenario, 20 

RDP, 21 
SINUMERIK, 21 
Sm@rtAccess, 20 

Applications, 53 
HMI device, 11 

Approvals, 24 
Auto-hide the taskbar, 77 
Autonegotiation, 61 
Autostart, 75 

B 
Background picture, 78 
Backup 

Configuration file, 82 
Basic adapter, 19 

Main dimensions, 117 
Basic knowledge 

Required, 3 
Bottom view 

Thin Client 10 inch Touch, 13 
Thin Client 15 inch Touch, 14 
Thin Client PRO 15 inch, 16 

C 
Cable 

Connecting, 44 
Calibrating 

Touch screen, 81 
Care, 111 
CE approval, 24 
Charge 

Electrostatic, 121 
Citrix, 71, 91 

Configuration settings, 71 
Clamping frame, 19 
Cleaning, 112 

Cleaning product, 111 
Clearance 

HMI device, 34 
Client - server 

Application scenario, 20 
Climatic 

Storage conditions, 28 
Transport conditions, 28 

Closing 
Rear wall, 52 

Commissioning engineers, 3 
Condensation, 28 
Conductor cross-section, 47 

Equipotential bonding, 45 
Configuration 

Server, 88 
Thin Client, 53 

Configuration file 
Backup, 82 
Editing, 82 
running, 82 

Configuration graphic 
Power supply, 47 
PROFINET, 49 

Configuration settings, 71 
Autostart, 75 
Calling, 54 
Changing the Administrator password, 56 
Checking the connection to the server, 60 
Citrix, 71 
Desktop, 76 
Device settings, 79 
Establishing names, 62 
Loss, 57 
Multiple access, 54 
Network settings, 58 
RDP, 67 
Read access, 55, 84 
Remote access, 63 
Sm@rtAccess, 69 
Special characters, 55 
VNC, 69 
Web browser, 73 
Write access, 54 
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Connecting 
Cable, 44 
Equipotential bonding, 45 
Mains terminal, 47 
Power supply, 47 
PROFINET, 49 
USB device, 49 

Connection 
Establishing the mode, 61 
Establishing the speed, 61 

Connection password, 75 
Connection sequence, 44 
Contact person, 5 
Control cabinet 

Working on, 23 
Conventions, 4 
C-Tick mark (Australia), 24 

D 
Degree of protection, 32 

IP54, 39, 40 
IP65, 19, 39, 40 
Protection against ingress of solid foreign 
bodies, 34, 36 
Protection against water, 34, 36 

Desktop 
Configuration settings, 76 

Device data 
Displaying, 80 

Device settings, 79 
Calibrating the touch screen, 81 
Displaying data, 80 
Establishing names, 62 
Running the configuration file, 82 
Saving the configuration file, 82 
Test hardware, 80 
Update firmware, 81 

Dimension drawings 
Basic adapter, 117 
Thin Client 10 inch Touch, 113 
Thin Client 15 inch Touch, 115 
Thin Client PRO 15 inch, 116 

Disposal, 5 
Disturbance 

Pulse-shaped, 26 
Sinusoidal, 27 

Documentation 
Enclosed, 37 
SIMATIC complete, 5 

E 
EC Declaration of Conformity, 24 
Electrical 

Safe separation, 48 
Electrical potential difference, 45 
Electrostatic charge, 121 
EMC 

Guideline, 24 
Emission, 25, 27 
Equipotential bonding 

Cable, 46 
Connecting, 45 
Requirements, 45 
Wiring diagram, 46 

Equipotential bonding rail, 46 
Expert mode 

SSH configuration service, 83 
Extension Unit 15",  

F 
Factory settings 

Restore, 55 
Firmware 

Update, 81 
Firmware version, 82 
Front view 

Thin Client 10 inch Touch, 12 
Thin Client 15 inch Touch, 14 
Thin Client PRO 15 inch, 16 

Function test, 50 

H 
Hardware 

Testing, 80 
Hide the taskbar, 77 
High frequency radiation, 23 
HMI device 

Applications, 11 
Clearance, 34 
EMC-compliant installation, 26 
Interface, 45 
Mounting, 38, 41 
Operator controls, 98 
Shutting down, 50 
Specifications, 118 
start, brief instructions, 22 
Switching on, 50 
Testing, 50 
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I 
Industry Portal, 5 
Input device 

Specifications, 118 
Insulation test 

Test voltage, 34, 36 
Interface, 45 
Interfaces 

Specifications, 118 

K 
Keyboard language, 88 

Windows XP Professional, 88 

L 
Labeling 

Approvals, 24 
EC Declaration of Conformity, 24 

Labeling, 24 
Layout 

In the web browser, 56 
Locking 

Touch screen, 112 

M 
Main dimensions 

Basic adapter, 117 
Thin Client 10 inch Touch, 113 
Thin Client 15 inch Touch, 115 
Thin Client PRO 15 inch, 116 

Mains terminal 
Connecting, 47 

Maintenance, 19, 111 
Maintenance personnel, 3 
Mechanical 

Storage conditions, 28 
Transport conditions, 28 

Monitoring mode, 95 
Mounting, 38, 41 

EMC-compliant, 26 
HMI device, 38, 41 
Mounting clamp, 39, 40 

Mounting clamp, 18, 19 
Mounting, 39, 40 

Mounting cut-out 
Dimensions, 33 
Preparing, 33 

Mounting location, 32, 36 
Mounting position 

Thin Client 10, 31 
Thin Client 15, 31, 35 

Multiple touch, 95 

N 
Network settings, 58 

valid settings, 60 
Non-isolated plant configuration, 48 

O 
Office location, 5 
Operating condition, 29 

Climatic, 30 
Mechanical, 29 
Tested for, 30 

Operating instructions 
Purpose of, 3 
Scope, 4 

Operating right, 96 
Operator controls, 98 
Operators, 3 

P 
Password 

Administrator password, 54 
Changing the Administrator password, 56 
Connection password, 75 

PELV, 48 
Peripherals 

Rated load, 49 
Pin assignment 

Power supply, 119 
RJ45 plug connector, 120 
USB socket, 120 

Plant configuration 
Non-isolated, 48 

Power supply 
Configuration graphic, 47 
Connecting, 47 
Pin assignment, 119 

PROFINET 
Configuration graphic, 49 
Connecting, 49 

PROFINET basic services, 85 
Protection class, 34, 36 
Protective foil, 19 
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Protective measure 
Static electricity, 122 

R 
Radiation 

High frequency, 23 
Radio interference, 25 

Emission, 27 
Rated load 

Interface, 49 
Rated voltage, 35, 36 
RDP, 21 

Application scenario, 21 
As autostart, 75 
Configuration settings, 67 
Interrupting the connection, 96 
Licensing, 87 
Restoring the connection, 96 

Rear view 
Thin Client 10 inch Touch, 13 
Thin Client 15 inch Touch, 15 
Thin Client PRO 15 inch, 17 

Rear wall 
Closing, 52 

Reconnect, 97 
Standard Reconnect, 97 

Recycling, 5 
Registered trademarks, 4 
Regulations for the prevention of accidents, 23 
Remote access, 63 
Repairs, 112 
Return Center, 112 
Reverse polarity protection, 48 
RJ45 plug connector 

Pin assignment, 120 

S 
Safe electrical isolation, 48 
Safety instruction, 49 

Connection sequence, 44 
Equipotential bonding cable, 46 
General, 25 
High frequency radiation, 23 
Malfunction, 49 
Mounting at an angle, 31 
Multiple touch, 95 
Preventing inadvertent operation, 111 
Rated load, 49 
Storage, 28 
Touch screen, 98 
Transport, 28 
Unintentional response, 111 
USB port, 49 
Working on the control cabinet, 23 

Safety regulations, 23 
Screen keyboard, 108 

Input focus, 109 
SHIFT key, 109 

Selecting 
Server, 101 

Server 
Configuration, 20, 88 
Interrupting the connection, 96 
Restoring the connection, 96 
Selecting, 101 

Service, 5 
Service pack 

Thin Client 10 Touch, 19 
Thin Client 15 Touch, 19 

Show the taskbar, 77 
Shutting down 

HMI device, 50 
Side view 

Thin Client 10 inch Touch, 12 
Thin Client 15 inch Touch, 14 
Thin Client PRO 15 inch, 16 
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Sm@rtAccess, 20 
Application scenario, 20 
As autostart, 75 
Configuration settings, 69 
Interrupting the connection, 96 
Licensing, 90 
possible HMI devices, 90 
Restoring the connection, 96 

Spare parts, 112 
Specifications 

Display, 118 
HMI device, 118 
Input device, 118 
Interfaces, 118 
Power supply, 119 
RJ45 port, 120 
Supply voltage, 119 

SSH configuration service, 83 
Start 

HMI device, brief instructions, 22 
Start bar, 99 

Auto-hide,  
Hide,  
Maximize, 99 
Minimize, 99 
Move, 99 
Show the taskbar, 99 

Static electricity 
Protective measures, 122 

Storage conditions, 28 
Strain relief, 51 
Supply voltage 

Specifications, 119 
Support 

Technical, 5 
Support Request, 5 
Supporting arm system 

Adapter set CP-L, 20 
Adapter set PLUS, 20 
Adapter set VESA 100, 20 
Adapter set VESA 75, 20 
Basic adapter, 19 

Switching on 
HMI device, 50 
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